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Release Notes

Includes product enhancements and notices, bug fixes, and resolved issues.

VMware vCenter Converter Standalone 6.6 Release Notes

This document contains the following sections

e Introduction

* What's in the Release Notes
* Resolved Issues

¢ Known Issues

Introduction

vCenter Converter Standalone 6.6 | 22 FEB 2024 | Build 23265344

What's in the Release Notes

The release notes cover the following topics.

What is New

* Added support for powered on virtual machines running under Red Hat KVM and Nutanix AHV.
¢ Migrated the vCenter Converter helper ISO to Photon OS operating system.

e Added support for Red Hat Enterprise Linux 8.0 (64-bit) and later minor versions.

* Added support for Red Hat Enterprise Linux 9.0 (64-bit) and later minor versions.

e Added support for Ubuntu Linux 18.04 LTS (64-bit).

¢ Added support for Ubuntu Linux 20.04 LTS (64-bit).

e Added support for Ubuntu Linux 22.04 LTS (64-bit).

* Updated the icons in the graphical user interface.

About vCenter Converter Standalone

VMware vCenter Converter Standalone provides an easy-to-use solution that automates the process of creating VMware
virtual machines from physical machines (running Windows and Linux) and other virtual machine formats. Through an
intuitive wizard-driven interface and a centralized management console, Converter Standalone can quickly and reliably
convert multiple local and remote physical machines without any disruptions or downtime.

¢ Convert physical machines running Windows or Linux operating systems to VMware virtual machines quickly and
without any disruption or downtime.

* Enable centralized management of remote conversions of multiple physical servers or virtual machines simultaneously.

* Ensure conversion reliability through quiesced snapshots of the guest operating system on the source machine before
data migration.

* Enable non-disruptive conversions through hot cloning, with no source server downtime or reboot.

Installation and Upgrade

You can download, install, and run VMware vCenter Converter Standalone in English only.
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Users with limited rights cannot install Converter Standalone on Windows. You must log in as an elevated administrator to
install Converter Standalone.

Product Interoperability

For the most up-to-date interoperability of Converter Standalone with VMware Desktop products and VMware vCenter
virtual machines, check the VMware Product Interoperability Matrix. In addition, Converter Standalone 6.6 supports as
sources physical machines running an operating system noted in the Supported Guest Operating Systems section.

Note: The interoperability information for VMware Workstation Player is published under the VMware Workstation product
with matching versions. For example, for interoperability with VMware Workstation Player 17.5, see VMware Workstation
17.5.

Supported Platforms

You can install VMware Converter Standalone 6.6 on the following platforms:

¢ Windows Server 2012 (64-bit)

*  Windows Server 2012 R2 (64-bit)
*  Windows 10 (32-bit and 64-bit)

¢ Windows Server 2016 (64-bit)

¢ Windows Server 2019 (64-bit)

*  Windows 11 (64-bit)

¢  Windows Server 2022 (64-bit)

VMware Converter Standalone can convert offline virtual machines from the following Hyper-V servers:

¢  Windows Server 2012 (64-bit)

¢  Windows Server 2012 R2 (64-bit)
¢ Windows 10 (64-bit)

*  Windows Server 2016 (64-bit)

¢  Windows Server 2019 (64-bit)

*  Windows 11 (64-bit)

¢ Windows Server 2022 (64-bit)

VMware Converter Standalone can convert offline virtual machines from the following VMware products and versions:

¢ VMware vSphere 7.0

* VMware vSphere 7.0 (Update 1)
¢ VMware vSphere 7.0 (Update 2)
¢ VMware vSphere 7.0 (Update 3)
¢ VMware vSphere 8.0

* VMware vSphere 8.0 (Update 1)
¢ VMware vSphere 8.0 (Update 2)
* VMware Workstation 17 and 17.5
* VMware Fusion 13 and 13.5

Supported Guest Operating Systems

Converter Standalone 6.6 supports the following guest operating systems:

¢  Windows Server 2012 (64-bit)
¢ Windows Server 2012 R2 (64-bit)
¢ Windows 10 (32-bit and 64-bit)
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¢ Windows Server 2016 (64-bit)

*  Windows Server 2019 (64-bit)

¢  Windows 11 (64-bit)

¢ Windows Server 2022 (64-bit)

¢ CentOS 6.x (32-bit and 64-bit)

*  CentOS 7.x (64-bit)

* Red Hat Enterprise Linux 6.x (32-bit and 64-bit)
¢ Red Hat Enterprise Linux 7.x (64-bit)
* Red Hat Enterprise Linux 8.x (64-bit)
* Red Hat Enterprise Linux 9.x (64-bit)
e Ubuntu 14.04 LTS (32-bit and 64-bit)
e Ubuntu 16.04 LTS (32-bit and 64-bit)
e Ubuntu 18.04 LTS (64-bit)

e Ubuntu 20.04 LTS (64-bit)

e Ubuntu 22.04 LTS (64-bit)

CAUTION: During cloning of powered on Linux machines, Converter Standalone preserves the following source file
systems on the destination: ext2, ext3, ext4, reiserfs, vfat, and xfs. All other source file systems are converted into ext3 or
ext4 file systems on the destination virtual machine.

For more information about the operating systems supported by Converter Standalone and other system requirements,
see VMware vCenter Converter Standalone System Requirements.

Product Support Notice

Support for authenticating with RSA SHA1 algorithms is deprecated. Instead, you can use newer algorithms or switch to
password-based authentication.

Customer Experience Improvement Program

This product participates in VMware’s Customer Experience Improvement Program (“CEIP”). Details regarding the data
collected through CEIP and the purposes for which it is used by VMware are set forth at the Trust & Assurance Center at
https://www.broadcom.com/company/legal/privacy/data-usage-programs/ceip. To join or leave the CEIP for this product,
please start Converter Standalone and select Customer Experience Improvement Program from the Administration
menu on the toolbar. Select the check box to join the CEIP or deselect the check box to leave the program.

Note: You can join the CEIP during the installation of vCenter Converter Standalone.

Caveats and Limitations

* vCenter Converter Standalone 6.5 does not exist. Version 6.5 is skipped on purpose to avoid possible confusion with
VMware vSphere 6.5.

» vCenter Converter Standalone supports source and destination disk drives with 512B (512e and 512n) disk sector size
only. 4K native (4Kn) disk drives are not supported.

Resolved Issues
Converter Standalone fails to start when installed on a computer without internet access

After you install Converter Standalone on a computer without internet connection, Converter Standalone services fail
to start. The following message is displayed: Error 1053: The service did not respond to the start
or control request in a timely fashion . This issue occurs because the DNS server is not able to resolve
host names online and the file integrity check exceeds the default timeout of 30 seconds due to failed access to public
certificate authority stores. This issue is resolved in this release.
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After a P2V conversion of an Ubuntu Linux machine, the converted machine might not start

When you convert an Ubuntu Linux machine and the root volume is a logical volume, the start of the converted VM might
fail with an error message: "Kernel panic - not syncing: VFS: Unable to mount root fs on unknown-
block (0, 0) " . This issue is resolved in this release.

After a P2V conversion of a Linux machine, the converted machine might not start

When the converted VM starts, the boot screen displays error messages with repeating lines containing the following
error: can't find command :'. This issue is resolved in this release.

Reconfiguration of Linux VM fails at 97-98%, with message: “Error: Unable to reconfigure the destination virtual
machine” and the status contains “message: FATAL: kernel too old”

Some Linux distributions have unsupported combinations of Linux kernel and grub loader. This issue is resolved in this
release.

Destination virtual machine might not boot if you change the disk controller type while converting a Linux virtual
machine

In Linux virtual machines, the root device can be defined using the block device name (such as /dev/sdal )in /boot/
grub/grub.conf, /boot/grub/menu.lst,or /etc/fstab . If you change the disk controller type while converting
the virtual machine, the destination virtual machine might not boot. This is because the root device now has a different
name (for example, it might have been changed to /dev/hdal ). This issue is resolved in this release.

Known Issues

The known issues are grouped as follows.

Installation
Converter Standalone installation fails when the selected installation folder name contains non-ASCIl characters

Converter Standalone installation fails if the installation folder name contains non-ASCII characters and the OS locale is
different from the locale of the characters. If there are characters from two different locales mixed in the folder name, the
installation fails because there is always a character with different locale than the OS locale.

Workaround: Make sure that all the non-ASCII characters in the folder name are from the same locale as the OS locale.

If the name of the Converter Standalone installation directory contains non-ASCII characters, you might
experience conversion and configuration problems

If the name of the Converter Standalone installation directory contains non-ASCII characters, the following issues might
occur:

* Conversion and configuration of Windows virtual machines might fail with an error message Unable to
reconfigure destination virtual machine.Inthe vmware-converter-worker.log, this error
generates a message similarto Error 3 (error restoring key: Unknown error 3 (0x3) (3))
restoring registry key C:\d—&"a¥&-d<&nA°...\data\SKUNKWORKS FILLER into...

» If you try to convert a Linux physical machine, you might receive an error message in the Convert Machine wizard
Unable to obtain hardware information.

Workaround: None.
You must restart machines that run 64-bit Windows Vista or later before reinstalling Converter Standalone

If you uninstall Converter Standalone from a 64-bit Windows Vista, Windows Server 2008, or Windows 7 machine and do
not restart it, a subsequent Converter Standalone installation might fail with the following error message: Error 29144.
Could not install service Vstor2 MntApi 1.0 Driver (shared). Please reboot and try to
install again.
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Workaround: Restart the Windows Vista, Windows Server 2008, or Windows 7 machine and try installing Converter
Standalone again.

Users with limited rights cannot install Converter Standalone on Windows

If you are logged in to Windows as a non-administrator user, the following error message is displayed while the
InstallShield is extracting files for Converter Standalone installation: Unable to save file: C:\WINDOWS
\Installer\ The system cannot find the path specified. The erroris displayed because limited user
accounts do not have the required write permissions.

Workaround: Select the $TEMP% directory to extract the installation files:

1. Click OK in the error message. A Save As dialog box appears.

2. Browse to the Temp folder of the current user (for example, C: \Documents and Settings\"username"\Local
Settings\Temp ) and click OK.

NOTE: You still need to log in as an administrator to install Converter Standalone.

General
Disk-based cloning of a powered off machine image to a Virtual Volumes datastore destination might fail

You might not be able to perform a disk-based cloning of a powered off machine image to a Virtual Volumes datastore
destination. The conversion might fail at 1% with a message Operation experienced network error if the size of
the source disk is not a number that is a multiple of a MB.

Workaround: Use volume-based cloning, if the option is available.

Creation of virtual machine with thick destination disk type of certain size fails on VSAN datastore even if it
seems to have enough space

If you try to perform disk-based conversion with thick destination disk type of certain size on VSAN datastore, the creation
of virtual machine might fail with the following error ' converter.fault.InsufficientManagedDiskSpace' , even
if it seems to have enough space.

Workaround: Change the destination disk type to thin.

If you try to convert a source physical or virtual machine to a managed destination by using thick provisioned
disks with large empty spaces on them, the conversion task might fail

If you try to perform a disk-based cloning of a physical or virtual machine to a managed destination by using thick
provisioned disks with large empty spaces on them, the conversion task might fail with an error message Unable to
clone disk source disk on the virtual machine virtual machine name . The following messages
appear in the log file:

[03200 warning 'Default'] [,0] [NFC ERROR] NfcNetTcpRead: bRead: -1[03200 warning
'Default'] [,0] [NFC ERROR] NfcNet Recv: requested 264, recevied only 0 bytes[03200
warning 'Default'] [,0] [NFC ERROR] NfcFile Stream: Failed to get message from
source[03200 warning 'Default'] [,0] [NFC ERROR] NFC NETWORK ERROR

The destination ESXi server must return an acknowledgement after each processed NFC write request. If the source
sends a large block of zeroes that must be written it might take a long time for the ESXi to return the acknowledgement.
Thus, the Converter assumes that the operation has timed out and closes the connection, no matter that the ESXi server
is still writing to the target disk.

Workaround: Change the destination disk type to thin.

A running P2V conversion job fails if you create a new conversion job for the same Windows source machine and
use a different port to deploy the Converter Standalone agent

If, while running a P2V conversion job, you start creating another conversion job for the same powered on Windows
source machine, and specify a port for the connection, Converter Standalone deploys the Converter Standalone agent
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using the port you specified. If the connection port is different from the one that is being used for the already running
conversion job, both jobs fail. The following error message appears in the Job summary tab for the first conversion job:
FAILED: A general system error occurred: No connection could be made because the target
machine actively refused it . The following error message appears in the Job summary tab for the second
ConvemkHUObSFAILED: Unable to create a VSS snapshot of the source volume(s). Error code:
2147754774 (0x80042316) .

Workaround: None.
You cannot copy running conversion or configuration jobs

If you open the Copy As New wizard for a running configuration or conversion job when the source is a virtual machine
or a backup image and you click Next, the wizard displays the error message Unable to obtain hardware
information for the selected machine.

Workaround: Wait for the job to complete before selecting Copy as New in its pop-up menu.
Linked Cloning of source images greater than 2 GB to a network share that does not support large files fails

Creating linked clones from source images that are larger than 2 GB to a network share that does not support large files
(for example, to a Linux SMB share) fails. Converter Standalone does not split the source files into smaller chunks. If the
source is larger than the supported file size on the destination, the conversion tasks fails.

Workaround: None.

Creating a conversion job to convert a standalone VMware source with a VMDK file greater than 2 GB from a
network share that does not support large files, fails

If you select a standalone virtual machine source with VMDK file greater than 2 GB residing on a remote network location
that does not support large files (for example, Linux SMB share), the following error message appears in the Converter
wizard on clicking Next or View source details: Unable to obtain hardware information for the selected
machine.

Workaround: Map the network shared folder to the machine where Converter Standalone runs, and select the source from
there.

Converter Standalone cannot detect the power state of VMware Workstation or other VMware hosted source
virtual machines if they are located on a read-only network share

If the source machine is a Workstation or another VMware hosted source and is located on a network share with read-
only permissions, Converter Standalone cannot detect if the source is powered on or suspended. This might lead to
data inconsistency on the destination machine if changes are made to the powered on source virtual machine during
conversion.

Workaround: Perform one or more of the following tasks.

* Verify that the source virtual machine is powered off prior to conversion.
» Provide write privileges to the network share where the source virtual machine resides.

Converting source volumes with unrecognized file systems might prevent the destination virtual machines from
starting

While you are setting up a volume-based cloning task in one of the Converter Standalone wizards, the volume name
might be missing in some rows of the Source Volumes tab. This means that Converter Standalone does not recognize
the file system on those volumes. The destination virtual machine that is created as a result of such a conversion task
might fail to start up. Nevertheless, Converter Standalone copies the source volume data to the destination using block-
level copying.

Workaround: Configure the destination virtual machine after the conversion.

Converting standalone VMware sources with a VMDK file greater than 2 GB to a hosted destination that resides
on a network share that does not support large files, fails
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If you select a standalone virtual machine source with VMDK file greater than 2 GB and try to convert it to hosted
destination residing on a remote network location that does not support large files (for example, Linux SMB or NFS share),
the conversion job might fail with one of following error messages:

* Unable to connect to the virtual disk
* Remote server closed connection after 0 response bytes read
* An error occurred during an operation on a virtual disk

If conversion is successful, the following error message related to the VMDK file might appear when you power on the
destination virtual machine: Internal Inconsistency errors

Workaround:

1. In the main application window of Converter Standalone, right-click the failed job and select Copy As New...

2. Go to the Options page and select Data to Copy.

3. In the Data to Copy pane, select the volumes to copy and click Advanced.

4. On the Destination layout tab, select Split not pre-allocated or Split pre-allocated as the destination disk type.
5. Click Next to view a summary of the conversion job.

6. On the Ready to Complete page, click Finish to resubmit the job.

Converter Standalone is unable to detect the system volume if it resides on a SCSI disk and IDE disks are present
in the source machine

On source machines with SCSI and IDE disks, Converter is unable to detect the system volume if the system volume
resides on a SCSI disk. Converter only checks the first IDE disk in such configurations.

Workaround: None.

If the hardware configuration of the source machine is modified while the Conversion wizard is open, you need to
restart the conversion wizard if you want to view correct source details

Source machine details are retrieved per wizard session, as this is a time-consuming process. If some changes occur
on the source machine (such as adding memory or hard drives) after this information is retrieved, the Conversion wizard
does not show information about the changes.

Workaround: Restart the conversion wizard.

Cloning a source that contains file system errors might result in a damaged virtual machine
See Cloning a source that contains file system errors may result in a damaged copy (KB 1006689).
Timeout on SSL handshake when converting over a WAN link

Converter Standalone does not support conversion over a WAN. When trying to perform a conversion over a WAN link,
you might experience an SSL timeout because the timeout for SSL handshakes is two minutes.

Workaround:

1. To avoid the two-minute handshake, perform a conversion to a hosted destination machine (for example, Workstation)
in the same LAN.

2. Copy the temporary virtual machine and send it over the WAN to the remote site.
If the intended destination is a Workstation virtual machine, this completes the process.
3. If the intended destination is ESXi, import the Workstation virtual machine to the ESXi server.

The Reconfigure Virtual Machine wizard does not display correctly the vDS port group name

When you reconfigure a virtual machine that uses dvSwitch and you navigate to the Network interface settings pane,
the Network name text box does not display the name of the dvSwitch after the port group name. Only port group is
displayed instead.

Workaround: None.
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The reported network transfer rate might not be correct

The reported network transfer rate might be higher than the actual one because of the inherent compression used by the
network protocol. This does not affect the network throttling.

Workaround: None.
Multiboot configurations are not supported for conversion

Converter does not recognize proper boot and system volumes in multiboot source machines due to the multiple choices
and the reconfiguration of the virtual machine might fail.

Workaround: Remove the multiboot configuration and leave only one to be converted.

Windows Sources
When starting a Windows P2V conversion with synchronization, an error message might be displayed

On the Options page of the vCenter Conversion wizard, if Data to copy in selected in the options list, some volumes
might be displayed by default as Min size . When starting a volume-based conversion of a Windows source machine,
vCenter Converter treats these volumes as resized and triggers file-level cloning. As a result the conversion operation
might fail with the following error message: Synchronization cannot be enabled if one or more volumes
require file-level cloning.

Workaround: Perform the following tasks.

1. In the vCenter Conversion wizard, on the Options page, click Data to copy.
2. Ensure that all volumes have Destination size setto Maintain size.

A conversion operation might fail with an error message

When Microsoft Windows operating system fails to create a VSS snapshot of a mirrored volume, that is formatted
with FAT or FAT32 file system, the conversion operation in vCenter Converter might fail with the following error
message: FAILED: Unable to create a VSS snapshot of the source volume(s).

Workaround: Before the conversion operation, perform one or more of the following tasks.

¢ Exclude the mirrored FAT or FAT32 volume.
¢ Break the mirrored volume on the source machine.

After a successful conversion of a Windows machine that uses LDM, mounted volumes without drive letters on
the source machine might be presented with drive letters on the destination machine

This is expected behavior. During the conversion process, vCenter Converter assigns drive letters to all volumes on the
destination machine.

Workaround: Remove the drive letters, then mount the volumes to the desired folders.
Conversion operation of a Windows machine with EFl firmware and a mirrored system volume might fail

The conversion operation might fail at 96% - 98% for powered on or volume-based powered off Windows machines with
UEFI firmware, where the system volume resides on a mirrored dynamic disk. The following error message appears in the
status line of the task progress tab: "FAILED: Unable to find the system volume, reconfiguration is
not possible."

Workaround: Before the conversion, remove the mirroring on the source machine.
During a conversion operation, the services that run on source machine, might fail to stop

During the final synchronization of a Windows P2V conversion operation, the services on the source machine might fail to
stop and no error or warning message is displayed.

Workaround: Before the final synchronization, stop the services manually.
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When converting a remote Windows Server 2012 or Windows Server 2008 R2 machine, the conversion operation
might fail

During the conversion operation of a remote Windows Server 2012 or Windows Server 2008 R2 machine, vCenter
Converter might fail to deploy the Converter agent with the following error message: Unable to complete
Converter agent installation on ... Error code: 1603. The manual installation of the agent on the
source machine might fail with the following error message: openssl.exe - System Error The program can't start because
api-ms-win-crt-stdio-11-1-0.dll is missing from your computer. Try reinstalling the program to fix this problem.

Workaround: Perform one or more of the following tasks.

* Install the latest Windows updates on the source machine.
* In the operating system of the source machine, download and install Visual C++ Redistributable for Visual Studio 2015.

During a cloning operation of a remote Windows machine, the deployed vCenter Converter agent service might
not start.

After deployment of the vCenter Converter agent, the agent might fail to start with the following error message: Unable
to complete Converter agent installation on ... Error code 1603.

Workaround: Wait for a few seconds and retry the operation.

A volume-based conversion operation of a Windows Server 2019, Windows Server 2022, or Windows 11 machine
with EFI firmware to hosted destination, such as VMware Workstation, VMware Player, or VMware Fusion, might
fail

This is a conversion limitation, and the error is due to vCenter Converter not being able to clone the ESP (EFI system
partition). Typically, the conversion operation fails at 1% with the following error in the status line of the task progress tab:
FAILED: An error occurred during the conversion: 'Cannot format volume.'

Workaround: None.
A converted virtual machine might enter the BIOS screen instead of starting

The converted machine might not start, if the source is a powered off VM with a non-bootable disk on IDE controller, the
bootable disk is on IDE controller, and the conversion is set to preserve disk controllers.

Workaround: In the properties of the converted virtual machine, change the controller type of bootable disk to SATA or
SCSI.

When converting an offline Windows 11 machine or Windows machine with encryption on the disk or the
hypervisor policy, the conversion operation might fail

The conversion operation might fail with the following error message: FAILED: An error occurred during the
conversion: 'Unable to open destination disk'.

Workaround: In the vSphere inventory, locate the virtual machine and change the encryption options.

From the vSphere Client home page, select Hosts and Clusters.

In the vSphere inventory, right-click the virtual machine that you want to modify and select Manage Snapshots.
In the Snapshot Manager, select Delete all.

In the vSphere inventory, right-click the virtual machine that you want to modify and select Edit Settings.

On the Virtual Hardware tab, expand Hard disk, and change VM storage policy to Datastore Default or any policy
without encryption.

On the Virtual Hardware tab, locate the Trusted Platform Module entry, move your pointer over the device and click
the Remove icon.

On the Virtual Hardware tab, click Delete to confirm you want to remove the device.
On the VM Options tab, expand Encryption.

From the Encrypt VM drop-down menu, select None.

0 Deselect the check box for Virtualization Based Security.
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11. Click OK.

After a successful conversion of a powered-on Windows source machine, one or more volumes might be missing
from the destination machine

After a successful conversion of a powered-on Windows source machine, one or more volumes might be missing from the
destination machine. This issue occurs if there are raw volumes on the source Windows machine because the Converter
Standalone might not be able to detect them and might skip them during the query and the conversion.

Workaround: If the source machine has raw volumes, format them with a file system that is supported by the source’s
operating system before moving forward with the conversion.

After a successful conversion of a Windows machine that uses LDM, the drive letters of dynamic volumes from
the source machine might not be preserved on the destination virtual machine

After the conversion of a Windows machine that uses LDM, the drive letters of dynamic volumes from the source machine
might not match the drive letters of the corresponding volumes on the destination machine.

Workaround: You can assign drive letters to volumes manually. If the letter you wish to assign to a volume is already in
use by another device, you can make it available either by assigning a different drive letter to this device or by removing
the drive letter.

Cannot virtualize a physical machine from within VMware Fusion 10.x
Interoperability with VMware Fusion 10.x does not work.
Workaround:

1. Create a shared folder on the destination machine and give the local Administrators group full control.

2. Connect Converter to a host such as 1ocalhost and use a user from the local Administrators group.

3. Verify that the firewall, the UAC, and the remote-UAC are deactivated for the source and the destination machines.

4. Start the conversion job by selecting the source machine under Powered on: This local machine or Remote
Windows machine.

5. Select as target VMware Workstation or other VMware virtual machine and then select the appropriate destination
format VMware Fusion 8.x.

Note: For more details, see Select a Powered On Windows Machine to Convert, and Select a Hosted Destination in the
vCenter Converter Standalone documentation set.

Attempting to convert a remote Windows machine with Windows Vista or later with a remote administrative user
results in "Permission denied"” or "Unable to perform operation” errors, or the remote machine refuses to accept
the administrator account

When you attempt to convert a remote Windows machine with Windows Vista or later by deploying and using

the Converter Agent, the installation of the agent results in "Permission denied" or "Unable to perform
operation" errors, or if the Agent is installed on the remote machine, the machine refuses to accept the administrator
account. This is the result of the Remote Connection UAC which does not allow administrators to perform administrative
tasks when connected remotely.

Workaround: Deactivate the Remote Connection UAC.

1. Modify the policy.

— For Windows Vista and Windows Server 2008, open the HKEY LOCAL MACHINE\SOFTWARE\Microsoft
\Windows\CurrentVersion\Policies\System registry key and create or modify a DWORD32 value
LocalAccountTokenFilterPolicy = 1.

— For Windows 7 and later, deactivate the policy named "User Account Control: Run all administrators
in Admin Approval Mode" in gpedit.msc:Computer Configuration/Windows Settings/Security
Settings/Local Policies/Security Options/ .

2. Restart the source machine.



https://techdocs.broadcom.com/us/en/vmware-cis/vsphere/vcenter-converter/6-6/vmware-vcenter-converter-standalone-documenation-6-6/convert-a-physical-or-virtual-machine/select-a-source-machine-to-convert/select-a-powered-on-windows-machine-to-convert.html
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3. Convert the machine, then restore the settings on the source and the destination machines.

When customizing a Windows 10 or Windows Server 2016 machine, sysprep started by the customization
process might fail

When customizing a Windows 10 or Windows Server 2016 machine, sysprep started by the customization process might
fail with the following error "Windows installation encountered an unexpected error. Error code:
0xC0000005" , making the target VM unusable.

Workaround: Do not apply customization on the target VM. Do the operations manually in the VM after the conversion.
Customization might not be applied on Windows source machines

After the conversion of a Windows source machine, the selected customization options are not applied on the resulting
VM and the c:\windows\system32\sysprep\panther\setuperr. log file might be empty or contain the following
lines similar to:

2015-12-04 01:51:21, Error SYSPRP Failed to remove staged package

Microsoft.Windows.Photos 15.1120.13270.0 x64 8wekyb3d8bbwe: 0x80070002.[gle=0x00000002]
2015-12-04 01:51:21, Error SYSPRP Failed to remove apps for the current user:
0x80070002.2015-12-04 01:51:21, Error SYSPRP Exit code of RemoveAllApps thread was
0x2.2015-12-04 01:51:21, Error SYSPRP Failed to remove all apps: 0x80070002.2015-12-04
01:51:21, Error [0x0f0082] SYSPRP ActionPlatform::LaunchModule: Failure occurred

while executing 'SysprepGeneralize' from C:\Windows\System32\AppxSysprep.dll;

dwRet = 0x22015-12-04 01:51:21, Error SYSPRP ActionPlatform::ExecuteAction:

Error in executing action; dwRet = 0x22015-12-04 01:51:21, Error SYSPRP

ActionPlatform: :ExecuteActionlList: Error in execute actions; dwRet = 0x22015-12-04
01:51:21, Error SYSPRP SysprepSession::Execute: Error in executing actions from C:\Windows
\System32\Sysprep\ActionFiles\Generalize.xml; dwRet = 0x22015-12-04 01:51:21, Error SYSPRP
RunPlatformActions:Failed while executing SysprepSession actions; dwRet = 0x22015-12-04
01:51:21, Error [0x0f0070] SYSPRP RunExternalDlls:An error occurred while running registry
sysprep DLLs, halting sysprep execution. dwRet = 0x22015-12-04 01:51:21, Error [0x0f00a8]
SYSPRP WinMain:Hit failure while processing sysprep generalize internal providers; hr =
0x80070002

Note: The error code 0x80070002 and the application Microsoft.Windows.Photo are used as an example and might
be different in the c:\windows\system32\sysprep\panther\setuperr.log file on the resulting VM.

This is a result of multiple users logging in to the machine and installing or updating the Metro Apps.
Workaround: Perform one or more of the following tasks.

* On the source machine, apply the workaround in Sysprep fails after you remove or update Windows Store apps that
include built-in Windows images, and repeat the conversion operation.

* On the destination machine, apply the workaround in Sysprep fails after you remove or update Windows Store
apps that include built-in Windows images, and run the following command: c: \windows\system32\sysprep
\sysprep.exe /generalize /oobe /reboot /unattend:c:\sysprep\sysprep.xml

* After the conversion, configure the destination virtual machine and reapply the customization steps.

Conversion job with no volume selected for shrinking fails with the following error message: 'An error occurred
during the conversion: 'Block level cloning does not support shrinking volumes'

Converting a Windows source that has an LDM volume that is larger than 2 TB and the first disk of the volume is an MBR
disk fails with the following error message: 'An error occurred during the conversion: 'Block level
cloning does not support shrinking volumes' . Converter attempts to create an MBR disk larger than 2 TB
on the destination but the limit of MBR disks is 2 TB.

The error does not occur on LDM volumes with a GPT first disk, because the destination disk type supports sizes larger
than 2 TB.
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Workaround: Convert the LDM volume at file level. Trigger the file-level cloning by shrinking volume size.

Unsupported guest operating systems are labeled Other and fail to assign correct values for disk and network
controllers

If you convert a virtual machine that is running on a Windows 8, Windows 8.1, or Windows 10 guest operating system
to ESXi version earlier than 6.0, the conversion results in a VM that cannot boot or does not have networking. The VM
settings list the guest operating system as Other instead of Windows 8, Windows 8.1, or Windows 10.

Workaround: Perform one or more of the following tasks.

¢ Select a destination ESXi which supports Windows 8, Windows 8.1, or Windows 10.
* Manually select disk controller and network controller before conversion.

If you convert a source machine with Windows 2008 and above operating system, some disk(s) may be offline or
read-only

If you convert a source machine with Windows 2008 and above operating system, some disk(s) in the destination VM may
be offline or read-only.

Workaround:

* If the disk is offline, in the Disk Management console di skmgmt .msc , right-click the disk and select Online .
* If the disk is read-only, run diskpart.exe with administrator's rights, and then run the following commands:
a. DISKPART> list disk
Lists all disks and their status: online/offline.
b. DISKPART> select disk #
Where "#" is the number of disk in offline state.
DISKPART> attribute disk clear readonly
DISKPART> online disk
Repeat steps 2-4 for every offline disk.
DISKPART> exit

~0ao0

Configuration of Windows virtual machines with multiple active partitions might not complete

For Windows virtual machines with multiple active partitions, Converter Standalone might not recognize the boot
partition and might not be able to complete the reconfiguration of the destination virtual machine. In such cases, after
the conversion job is 96-98% complete, the conversion job status changes to Failed and an error message appears.
For example: FATLED: Unable to find the system volume, reconfiguration is not possible.
In the Worker/Agent log this issue is identified by the following statement: [#### warning 'Default'] ERROR:
[Mntapi GetFirstBootDisk] more that *one* active volume found. Current active disk #0,
another active disk #1.

Workaround: Perform one or more of the following tasks.

* Mark all non-boot active partitions on the destination machine as inactive and run configuration on the destination
machine.

1. Boot into Windows Recovery Console on the destination machine.
2. Run diskpart.exe.
The diskpart command prompt appears.
3. (Optional) To list the available disks, enter 1ist disk.
4. Enter select disk <disk number>.
5. (Optional) To list the partitions on the selected disk, enter 1ist partition.
6. Enter select partition <partition number>.
7. Enter inactive.
8. Repeat steps 4-7 to mark another partition as inactive.
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. Power off the destination machine.
10. Run Converter Standalone and configure the destination machine.

* Mark all non-boot active partitions on the destination machine as inactive and run configuration on the destination
machine.

1. On the source machine, run diskpart.exe.

The diskpart command prompt appears.

(Optional) To list the available disks, enter 1ist disk.

Enter select disk <disk number>.

(Optional) To list the partitions on the selected disk, enter 1ist partition.
Enter select partition <partition number>.

Enter inactive.

Repeat steps 2-6 to mark another partition as inactive.

Run Converter Standalone and start the conversion again.

® N ok wN

Conversion of a local powered on source machine fails at 1%

If you select This local machine as a conversion source and a Converter Standalone agent from a previous Converter
Standalone version is installed on the source machine, the conversion task fails at 1%. The following error message
appears in the Status line of the Task progress tab: FATILED: Unable to create a VSS snapshot of the
source volume (s). Error code: 127 (0x0000007F) . This is because the Converter Standalone installer
cannot upgrade previous versions of Converter Standalone agents.

Workaround: Manually uninstall Converter Standalone agent from the source machine and create a new conversion task.

Converter Standalone worker process stops responding if you try to copy a configuration job during guest
operating system customization

If you right-click a running configuration job and select Copy As New while the destination machine is being customized,
Converter Standalone worker process stops responding.

Workaround: Wait for the configuration job to complete before you copy it.

Subsequent P2V conversions of remote source machines that run 64-bit Windows Vista or later might fail after a
successful conversion

If you convert successfully a remote source machine that runs 64-bit Windows Vista, Windows Server 2008, or Windows 7
operating system and then try converting it again, the conversion fails with the error message Converter Standalone
Agent installation failed on x.x.x.x Error code: 1603, where x.x.x.x is the IP address of the source
machine. This error message might occur if automatic uninstall of remote Converter Standalone agent has been enabled
during the first successful conversion.

Workaround: Restart the remote source machine and try running the conversion task again.

Converter Standalone does not preserve disabled network adapters during conversion of physical machine
sources that run on Windows

During P2V conversion of Windows source machines, Converter Standalone does not detect disabled network adapters
on the source and does not preserve them on the destination virtual machine.

Workaround: On the Options page of the Converter Standalone wizard, click Networks to add network adapters to the
destination virtual machine.

Converter Standalone does not support cloning of powered on sources with Windows Server 2008 or later with
FAT/FAT32 volume file system

VSS under Windows Server 2008 or later does not support FAT/FAT32. Trying to convert a FAT/FAT32 volume causes the
conversion task to fail.
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Workaround: Deselect all FAT/FAT32 volumes on the Options page of the Conversion wizard.

Previous Converter versions cannot convert source machines that have Converter Standalone 6.x agent installed
on them

Converter Standalone 6.x agent is deployed on the source machine during conversion. If Converter Standalone 6.x agent
is not uninstalled after the conversion, older Converter versions cannot deploy their agents on top of the newer Converter
Standalone agent version. Therefore, you cannot use previous Converter versions to convert sources that have already
been converted with Converter Standalone 6.x.

Workaround: Uninstall Converter Standalone 6.0 agent before trying to convert the source with an older Converter
version.

Owner name and organization are not displayed properly after customizing the guest operating system

After customizing the guest operating system, Unicode characters used for owner name and organization on the
Computer Information page do not appear the way they were set in the Conversion or the Configuration wizard.

For all Windows operating systems except Windows Vista, customization parameters such as user name and organization
must use characters only from the local encoding of the default user profile of the guest. For example, you can use
Japanese characters for the user name only on a guest whose default user profile's local encoding is set to Japanese.
These restrictions do not apply to Windows Vista guests because Windows Vista uses a UTF-8 encoded XML file to store
the Microsoft sysprep parameters. Earlier versions of Windows use the sysprep. inf file, and the Microsoft Windows
mini-setup process reads that file in the local encoding only.

Workaround: Avoid Unicode characters when assigning owner name and organization name for the destination virtual
machine.

Converter can convert FAT/FAT32 volumes during hot cloning only if the source machine has at least one NTFS
volume

For source machines running under Windows versions earlier than Windows Server 2008, VSS can take snapshots of
FAT/FAT32 volumes only if the source machine has at least one NTFS volume. For all operating systems that support
volume-based cloning, you need at least one NTFS volume for VSS to work.

Workaround: None.
Converter Standalone agent does not start automatically after reboot

If the source machine starts up too slowly, Converter Standalone agent might not start automatically after the source
machine is restarted.

Workaround: Start the Converter Standalone agent manually.

1. Right-click My Computer and select Manage.

2. In the Computer Management window, select Services and Applications > Services on the left.
3. In the list on the right, double-click VMware Converter Standalone Agent.

4. Click Start to start the process.

5. Click Apply followed by OK.

Sysprep deletes drive letter mappings during customization

If you choose customization options and the destination virtual machine fails at a Please Wait screen after the second
sysprep reboot, you need to rerun the conversion task without customization. This issue occurs because of a problem with
Microsoft sysprep, which deletes the drive letter mappings, preventing access to certain files.

Workaround: None.

User Account Control (UAC) prevents installing Converter Standalone agent if you are not using the default
Administrator account to connect to a powered on source machine
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If you are setting up a task to convert a powered on source machine that runs Windows Server 2008, Windows Vista,
Windows 7, Windows Server 2012, or Windows 8 and you use a non-default Administrator account to log in to the source
machine, the following error message might appear when you try to install Converter Standalone agent on the source
machine: Insufficient permissions to connect to xxxxxxx .Here xxxxxxx is the IP address of the source
machine. This is because Converter Standalone server cannot install Converter Standalone agent when UAC is activated
and you are logged in to the source as non-default Administrator user.

Workaround: Deactivate the UAC on the source machine before you start the Conversion wizard. You can search the
Microsoft Web site for procedures on deactivating the UAC depending on the source operating system. For Windows
Server 2012 and Windows 8, in addition to deactivating UAC, you must perform the following steps:

1. In the Windows Start menu, type gpedit.msc . The Local Group Policy Editor opens.

2. Navigate to Computer Configuration > Windows Settings > Security Settings > Local Policies > Security
Options.

3. Disable the Run all administrators in Admin Approval Mode setting.

4. Restart.

Adding a virtual machine to a domain might fail if you specify a fully qualified user name

When configuring a virtual machine, you might not be able to add the virtual machine to a domain if you use a fully
qualified user name (DOMAIN_NAME\USER _NAME).

Workaround: Specify the user name without including the domain name.

Linux Sources
After a conversion operation of a source machine with a volume that is formatted with ext4 , the volume might
be formatted with ext3 in the destination machine.

When the source machine is running a RHEL 6.x or Ubuntu 14.04 operating system and has volumes formatted with
ext4 file system, during the conversion process the volumes are formatted with ext 3 file system instead. The change
of the file system occurs due to the migration of the vCenter Converter helper ISO to Photon OS operating system.
The Converter helper service formats the volume with ext3 file system to allow RHEL 6.x and Ubuntu 14.04 operating
systems to read the volume after the conversion.

To preserve the ext4 volume in the destination machine, convert the source machine by using vCenter Converter 6.4.

After a conversion operation of a source machine with EFl secure boot enabled, the destination machine might
not be able to start

If secure boot is enabled, a converted machine might fail to start due to the version of the installed operating
system and you might receive the following error message on the UEFI boot screen: Attempting to startup
from: <OS>..Security Violation. ,where <OS> is the operating system of the machine.

Workaround: Perform one or more of the following tasks.

» After the conversion operation, in the VM settings of the virtual machine, disable the secure boot feature.

» Before the conversion operation, in the vCenter Converter wizard, select a virtual machine hardware version 19 or
earlier.
Note: This workaround is not applicable to all operating systems.

Conversion operation of a Linux machine where the boot volume resides on a BtrFS file system might fail
The conversion might fail with an error message in the status line of the task progress tab similar to:

'FAILED: An error occurred during the conversion: 'boost::filesystem::rename:
No such file or directory, "/mnt/p2v-src-root/root/boot/initramfs-3.10.0-1160.el7.x86 64.img"'

If /boot is a directory in the root volume and the root volume is on a BtrFS file system, the same issue might occur.

Workaround: None.
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Converting a Red Hat Enterprise Linux 7.6 or a CentOS 7.6 machine fails at 98% with Error: Unable to reconfigure
the destination virtual machine

Converting a powered-on Red Hat Enterprise Linux 7.6 or CentOS 7.6 machine with a kernel that was updated to
3.10.0-957.5.1 fails at 98% with the following error: Unable to reconfigure the destination virtual
machine . In the Task Progress tab, you see the following: An error occurred during the conversion:
'SysCommandWrapper: Error encountered in SysCommand: SysCommand failed to wait /usr/lib/
vmware-converter/chrootAndExec.sh to terminate.

Workaround:

1. Before the conversion, open a command line on the source machine and run the following command: yum
downgrade lvm2-1ibs-2.02.180-10.el7 6.2.x86 64 1lvm2-2.02.180-10.el7 6.2.x86 64 device-
mapper-event-1libs-1.02.149-10.el7 6.2.x86 64 device-mapper-1.02.149-10.el7 6.2.x86 64
device-mapper-1libs-1.02.149-10.el7 6.2.x86 64 device-mapper-
event-1.02.149-10.el7 6.2.x86 64

2. After the conversion, run yum update on the target machine.
Converting a powered-on Linux machine fails with the following error: “Unable to partition the destination disks”

Converting a powered-on Linux machine fails with the following error: Unable to partition the destination
disks . A message similar to: An error occurred during the conversion: Failed to find matching disk device
for VMODL Param Disk #0, 1447909153, controller: scsi, bus ID: 0, and unit ID: 0 appearsin
the Status line of the Task progress tab. This issue occurs if the disk controller type of the destination machine is set to
SCSI BusLogic.

Workaround: Select another disk controller type for the destination virtual machine.
Converter cannot query Linux source when a volume is mounted more than once

When the source machine has more than one mount point, you receive the following error message: Unable to query
the live Linux source machine. The worker log contains entry similarto: 2017-11-10T14:04:16.686+08:00
error vmware-converter-worker[03260] [Originator@6876 sub=Default] No disks for volume
with id '/dev/xvda2' and label '' . Converter expects each source file system to have a unique mount point.
Having more than one mount point per file system breaks the analysis of volumes and partitions.

Workaround: Unmount any of the double mounted file systems in the source machine so that there is only one mount
point per file system. Do not unmount the root (/) or boot (/boot) mount points. If any of them are mounted more than once,
unmount the other mount point or points.

Converted powered on Linux machines cannot start up

If you convert a powered on Linux machine that has a non-standard LVM filter saved in the /etc/1vm. conf file, the
converted virtual machine might fail to start up. The following error message appears in the virtual machine console:
Unable to access resume device (dev//)

Workaround: Before the conversion, edit the filter in the 1vm. conf£ file on the source Linux machine to allow all devices.
For Red Hat Linux, the default value of the filteris [ "a/.*/" 1.

Linux P2V conversion fails in the beginning with the following error message: 'A general system error
occured: &lt;source server_ dns name&gt;: Connection closed by remote host'’

If the source machine sshd is configured to allow less than 3 unauthenticated connections, it may sever the converter
connection.

Workaround: Check MaxStartups in /etc/ssh/sshd_config and ensure it is either commented out or its first number
is 3 or higher.

X Server might fail to start in destination virtual machines converted from sources that run Linux
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When the destination virtual machine starts, X server might fail to start with an error Fatal X server Error. Thisis
due to incompatibility issues between the display driver used in the Linux source and the display adapter of the destination
VMware virtual machine.

Workaround: Perform one or more of the following tasks.

» Install VMware Tools on the destination virtual machine.
» Configure the X server on the destination virtual machine to change the refresh rate and the display resolution.

Linked cloning of standalone VMware sources to Linux SMB shared destination fails

Linked cloning tasks of VMware standalone sources to SMB shared destinations that run on Linux fail with the following
error: converter.fault.FileIOFault.

Workaround: None.
The number of LVM logical volumes per volume group is limited to 12 for powered on Linux sources

During the conversion of powered on Linux machines, Converter Standalone converts LVM volume groups into new disks
on the destination virtual machine. The number of LVM logical volumes on a source LVM volume group cannot exceed 12.

Workaround: Move volumes out of the new disk to other destination disks.

1. On the Options page of the Conversion wizard, click Data to copy.
2. From the Data copy type drop-down menu, select Select Volumes to copy and click Advanced.

3. On the Destination layout tab, select a volume to move and click Move Up or Move Down until it is moved to the
destination disk.

You can move volumes between disks only if they are not Active /boot or System / volumes.
4. (Optional) To create a new destination disk, click Add Disk.

Source volumes on top of volume managers other than LVM are not recognized during conversion of powered on
Linux machines

Converter Standalone recognizes only managed source volumes that run on the LVM volume manager. Other volume
managers, including but not limited to Veritas Volume Manager (VxVM), are not recognized.

Workaround: None.
Converter Standalone does not recognize source volumes that reside on Linux Software RAID configurations

During cloning of powered on Linux machines, Converter Standalone does not recognize source volumes that are part of
a Software RAID configuration (also referred to as multiple disk, or MD, configurations).

Workaround: None.
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Using VMware vCenter Converter Standalone

The Using VMware vCenter Converter Standalone provides information about installing and using VMware®
vCenter Converter Standalone.

At VMware by Broadcom, we value inclusion. To foster this principle within our customer, partner, and internal community,
we create content using inclusive language.

All our documentation also comes in PDF format, which you can access by selecting the PDF download icon while
reading a page or viewing a search result.

Intended Audience

This guide is intended for users who want to install, upgrade, or use VMware vCenter Converter Standalone.

This guide is written for information systems engineers, software developers, QA engineers, trainers, and anyone who
wants to convert physical and virtual machines into VMware virtual machines.

Introduction to VMware vCenter Converter Standalone

VMware®vCenter Converter Standalone provides an easy-to-use solution that automates the process of creating VMware
virtual machines from physical machines (running Windows and Linux) and from other virtual machine formats.

Converter Standalone eases the exchange of virtual machines among the following products:

* VMware hosted products can be both conversion sources and conversion destinations.
— VMware Workstation™
— VMware Fusion Pro®
— VMware Workstation Player™

» Virtual machines running on an ESXi instance that vCenter Server manages can be conversion sources and the
corresponding ESXi and vCenter Server instances can be conversion destinations.

» Virtual machines running on unmanaged ESXi hosts can be conversion sources and the corresponding ESXi hosts can
be conversion destinations.

Migration with Converter Standalone

Migration with Converter Standalone involves converting physical machines and virtual machines for use in VMware
hosted and managed products.

You can convert virtual machines that vCenter Server manages for use in other VMware products. You can use Converter
Standalone to perform various types of conversion tasks.

» Import running remote physical and virtual machines as virtual machines to standalone ESXi hosts or to ESXi hosts
that vCenter Server manages.

e Import virtual machines hosted by or Microsoft Hyper-V Server to ESXi hosts that vCenter Server manages.
e Export virtual machines managed by vCenter Server hosts to other VMware virtual machine formats.

* Configure virtual machines managed by vCenter Server so that they are bootable, and install or customize their guest
operating systems.

* Customize guest operating systems of virtual machines in the vCenter Server inventory (for example, change the host
name or network settings).

* Reduce the time that is necessary to set up new virtual machine environments.

* Migrate legacy servers to new hardware without reinstalling operating systems or application software.

* Perform migrations across heterogeneous hardware.
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* Readjust volume sizes and place volumes on separate virtual disks.

Converter Standalone Components

The Converter Standalone application consists of Converter Standalone server, Converter Standalone worker, Converter
Standalone client, and Converter Standalone agent.

Converter Standalone server
Enables and performs the import and export of virtual machines. The Converter Standalone server comprises two services,
Converter Standalone server and Converter Standalone worker. The Converter Standalone worker service is always installed
with the Converter Standalone server service.

Converter Standalone agent
The Converter Standalone server installs the agent on Windows source machines to import them as virtual machines. You
can choose to remove the Converter Standalone agent from the source machine automatically or manually after the import is
complete.

Converter Standalone client
The Converter Standalone server works with the Converter Standalone client. The client component consists of the
Converter Standalone user interface, which provides access to the Conversion and the Configuration wizards, and lets you
to manage the conversion and the configuration tasks.

Cloning and System Configuration of Physical and Powered On Virtual Machines

When you convert a source machine, Converter Standalone uses cloning and system reconfiguration steps to create and
configure the destination virtual machine so that it works successfully in vCenter Server and hosted environments. The
migration process does not delete or modify the source and you can continue to use the original source machine after the
conversion completes.

Cloning is the process of copying the source disks or volumes for the destination virtual machine. Cloning involves
copying the data on the source machine’s hard disk and transferring that data to a destination virtual disk. The destination
virtual disk might have a different size, file layout, and other characteristics, and therefore might not be an exact copy of
the source disk.

System reconfiguration adjusts the migrated operating system so that it to functions on the new virtual hardware.

If you plan to run an imported virtual machine on the same network as the source machine, you must modify the network
name and IP address on one of the machines so that the source and destination machines can coexist. Besides, you must
make sure that the Windows source machine and the destination virtual machine have different computer names.

NOTE
Before converting a Windows machine, verify that you have the necessary Windows license.

Hot Cloning of Physical and Virtual Powered On Machines
With Converter Standalone, you can perform hot cloning.

Hot cloning, also called live cloning, or online cloning, consists in converting the source machine while it is running its
operating system. Hot cloning lets you clone machines without shutting them down.

During conversion, processes continue to run on the source machine, so the resulting virtual machine is not an exact copy
of the source machine.

When converting Windows sources, you can set Converter Standalone to synchronize the destination virtual machine

with the source machine after hot cloning. Synchronization is performed by transferring from the source to the destination
the blocks that were changed during the initial cloning period. To avoid loss of data on the destination virtual machine,
Converter Standalone can shut down certain Windows services before the synchronization. Based on your settings,
Converter Standalone shuts down the selected Windows services so that no critical changes occur on the source machine
while destination is being synchronized.
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Converter Standalone can shut down the source machine and power on the destination machine when the conversion
process is complete. When combined with synchronization, this action allows seamless migration of a source machine to
a virtual machine destination. The destination machine takes over the source machine operations with the least possible
downtime.

NOTE

When you hot clone dual-boot systems, you can clone only the default operating system to which the boot . ini
file or the BCD points. To clone the nondefault operating system, change the boot . ini file or the BCD to point
to the other operating system and reboot. After the other operating system is booted, you can hot clone it. If your
second operating system is Linux, you can boot it and clone it using the standard procedure for cloning Linux
powered on source machines.

Remote Hot Cloning of Powered On Source Machines That Are Running Windows

You can use the Conversion wizard to set up conversion tasks and Converter Standalone components perform all the
cloning tasks.

The following workflow is an example of remote hot cloning in which the powered on machine that is being cloned
experiences no downtime.

NOTE

With Converter Standalone 6.6, you can convert source Windows machines that have no direct access to the
destination ESXi server by using the proxy mode feature. The feature is available only for conversion of powered
on Windows sources to managed destinations.

1. Converter Standalone prepares the source machine for the conversion.
Converter Standalone installs the agent on the source machine, and obtains information about the hardware and the
operating system of the source machine.
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vCenter Converter Standalone
running on Windows machine

—
MNetwork
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2. Converter Standalone creates a virtual machine on the destination machine.
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3. Converter Standalone agent takes a snapshot of the source volumes and copies the source volumes machine to the

destination hypervisor.
If the proxy mode feature is off, the data traffic passes from the source machine directly to the destination server.
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If the proxy mode feature is on, the data traffic passes from the source machine through the Converter Standalone
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4. Converter Standalone finishes the conversion process.
The agent installs the drivers required for the operating system to start in a virtual machine and personalizes the virtual
machine (changes the IP information, for example).

dl
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5. Optionally, Converter Standalone uninstalls the agent from the source machine.
The virtual machine is ready to run on the destination server.

Remote Hot Cloning of Powered On Source Machines That Are Running Linux

The conversion process of powered on machines that are running Linux operating systems differs from the conversion of
Windows machines.

In Windows conversions, the Converter Standalone agent is installed on the source machine and the source information is
pushed to the destination.

In Linux conversions, no agent is deployed on the source machine. Instead, a helper virtual machine is created and
deployed on the destination ESXi host. The source data is then copied from the source Linux machine to the helper
virtual machine. After the conversion is complete, the helper virtual machine shuts down to become the destination virtual
machine the next time you power it on.

Converter Standalone supports conversion of Linux sources only to managed destinations.

The following workflow demonstrates the principles of hot cloning powered on source machines that run Linux to managed
destinations.

1. Converter Standalone uses SSH to connect to the source machine, deploys the sysinfo utility, and retrieves source
information. Converter Standalone creates an empty helper virtual machine based on your conversion task settings.
The helper virtual machine serves as a container for the new virtual machine during conversion. Converter Standalone
deploys the helper virtual machine on the managed destination, an ESXi host. The helper virtual machine boots from a
* . iso file that is located on the Converter Standalone server machine.
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2.

3.

4.
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The helper virtual machine powers on, boots from the Linux image, connects to the source machine through SSH, and
starts retrieving the selected data from the source. While you set up the conversion task, you can select which source
volumes to be copied to the destination machine.

Source
volumes —
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After data is copied, the destination virtual machine is reconfigured to allow the operating system to start in a virtual
machine.

Converter Standalone shuts down the helper virtual machine. The conversion process is complete.

You can configure Converter Standalone to power on the newly created virtual machine after the conversion is
complete.
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Types of Data Cloning Operations

Converter Standalone supports disk-based cloning, volume-based cloning, and linked-cloning modes.

Table 1: Cloning Modes

Data Copy Types Application Description
Volume based Copy volumes from the source machine to |Volume-based cloning is relatively slow.
the destination machine. File-level cloning is slower than block-

level cloning. Dynamic disks are converted
into basic volumes on the target virtual

machine.

Disk based Create copies of the powered off source You cannot select which data to copy. Disk-
machines, for all types of basic and based cloning is faster than volume-based
dynamic disks. cloning.

Linked clone Use to quickly check compatibility of Linked cloning is the fastest (but
VMware images. incomplete) cloning mode that Converter

Standalone supports.

Volume-Based Cloning

During volume-based cloning, volumes from the source machine are copied to the destination machine. Converter
Standalone supports volume-based cloning during hot cloning, and during the import of existing virtual machines.

During volume-based cloning, all volumes in the destination virtual machine, except LVM2 logical volumes, are converted
to basic volumes, regardless of their type in the corresponding source volume. LVM2 logical volumes can be preserved as
logical volumes during conversion.

Volume-based cloning is performed at the file level or block level, depending on the destination volume size that you
select.

Volume-based cloning at the file level
Performed when you select a size smaller than the original volume for NTFS volumes or you choose to resize a FAT volume.

For FAT, FAT32, NTFS, ext2, ext3, ext4, XFS, and ReiserFS file systems, Converter Standalone preserves the file system
type during a volume-based cloning at the file level.

Dynamic source disks are read but not preserved during volume-based conversions. Dynamic disks are converted into basic
volumes on the target virtual machine. Volume-based cloning of dynamic source disks at the file level is supported only for
Windows.

Volume-based cloning at the block level
Performed when you choose to preserve the size of the source volume or when you specify a larger volume size for NTFS
source volumes. Volume-based cloning at the block level is supported only for Windows.

Disk-Based Cloning
Converter Standalone supports disk-based cloning to import existing virtual machines.

Disk-based cloning transfers all sectors from all disks and preserves all volume metadata. The destination virtual machine
receives partitions of the same type, size, and structure, as the partitions of the source virtual machine. All volumes on the
source machine's partitions are copied as they are.

Disk-based cloning supports all types of basic and dynamic disks.
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Full and Linked Clones
Clones can be full or linked depending on the amount of data copied from the source to the destination machine.

A full clone is an independent copy of a virtual machine that shares nothing with the parent virtual machine after the
cloning operation. Ongoing operation of a full clone is separate from the parent virtual machine.

Because a full clone does not share virtual disks with the parent virtual machine, full clones generally perform better than
linked clones. Full clones take longer to create than linked clones. Creating a full clone can take several hours or even
days if the files involved are large.

You can create a full clone by using any disk clone type other than the linked clone type.

A linked clone is a copy of a virtual machine that shares virtual disks with the parent virtual machine in an ongoing
manner. A linked clone is a fast way to convert and run a new virtual machine. You can create a linked clone from the
current state, or snapshot, of a powered off virtual machine. This practice conserves disk space and lets multiple virtual
machines use the same software installation.

All files available on the source machine at the moment of the snapshot continue to remain available to the linked clone.
Ongoing changes to the virtual disk of the parent do not affect the linked clone, and changes to the disk of the linked clone
do not affect the source machine.

A linked clone must have access to the source. Without access to the source, you cannot use a linked clone.

For more information about how to create a linked clone, see Create a Linked Clone .

Using Converter Standalone with Virtual Machine Sources
With Converter Standalone, you can convert virtual machines and configure VMware virtual machines.

Converting virtual machines
You can convert VMware virtual machines from and to , , , ESXi Embedded, and ESXi Installable. You can also convert virtual
machines that Hyper-V Server manages into VMware virtual machines.

To run an imported VMware virtual machine and its source virtual machine on the same network, you must modify the
network name and IP address on one of the virtual machines.

Configuring virtual machines
If the VMware virtual machines have disks that have been populated by using a backup of a physical host, Converter
Standalone prepares the image to run on VMware virtual hardware. If you have used third-party virtualization software to
create a virtual machine on an ESXi host, you can use Converter Standalone to reconfigure it. You can also reconfigure
any operating system installed on a multiboot machine if you have imported the virtual machine to an ESXi host. Before you
reconfigure a multiboot machine, you must change the boot . in1i file or the BCD.

System Settings Affected by Conversion

A VMware virtual machine that is created by Converter Standalone contains a copy of the disk state of the source physical
or virtual machine. Some hardware-dependent drivers and sometimes the mapped drive letters might not be preserved.

The following source computer settings remain unchanged:

¢ Operating system configuration (computer name, security ID, user accounts, profiles, preferences, and so on)
¢ Applications and data files
* Volume serial number for each disk partition

Because the target and the source virtual machines have the same identities (name, SID, and so on), running them on the
same network might result in conflicts. To redeploy the source virtual machine, make sure that you do not run the source
and target virtual machines on the same network at the same time.
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For example, if you use Converter Standalone to test whether you can run a Hyper-V Server virtual machine as a VMware
virtual machine without first decommissioning the original Hyper-V Server machine, you must first resolve the duplicate

ID problem. You can resolve this problem by customizing the virtual machines in the Conversion or the Configuration
wizard.

Changes to Virtual Hardware After Virtual Machine Migration

After conversion, most applications function correctly on the VMware virtual machine because their configuration and data
files have the same location as on the source virtual machine. However, applications might not work if they depend on
specific characteristics of the underlying hardware, such as the serial number or the device manufacturer.

Several hardware changes might occur after you migrate a virtual machine.

Table 2: Hardware Changes After Virtual Machine Migration

Hardware Behavior

CPU model and serial numbers Might change after migration. They correspond to the physical computer hosting the
VMware virtual machine.

Ethernet adapters Might change for AMD PCNet or VMXnet and get different MAC addresses. The
IP address of each interface must be individually reconfigured.

USB adapters Might be updated during the cloning process.

Graphics cards Might change after migration (VMware SVGA card).

Disks and partitions The number of disks and partitions might change during the cloning process. Each disk

device might have a different model and different manufacturer strings.

Primary disk controllers Might differ from the source machine.

Applications that depend on devices that are not available within a virtual machine might not work after you migrate the
virtual machine.

System Requirements

You must consider the compatibilities and the interoperabilities among the systems on which and with which the Converter
Standalone components work.

Supported Operating Systems

You can install Converter Standalone components only on Windows operating systems. Converter Standalone supports
Windows and Linux operating systems as sources for powered-on-machine conversions and virtual-machine conversions.
You cannot reconfigure Linux distributions.

Table 3: Supported Operating Systems

Source for Powered |Source for
Converter

Supported Operating Systems Standalone Support On Mach.ine Virtual Machine Configuration Source
Conversions Conversions

Windows Server 2012 (64-bit) Yes Yes Yes Yes

Windows Server 2012 R2 (64-bit) | Yes Yes Yes Yes

Windows 10 (32-bit and 64-bit) Yes Yes Yes Yes

Windows Server 2016 (64-bit) Yes Yes Yes Yes
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Supported Operating Systems

Converter

Standalone Support

Source for Powered
On Machine
Conversions

Source for
Virtual Machine
Conversions

Configuration Source

Windows Server 2019 (64-bit) Yes Yes Yes Yes
Windows 11 (64-bit) Yes Yes Yes Yes
Windows Server 2022 (64-bit) Yes Yes Yes Yes
CentOS 6.x (32-bit and 64-bit) No Yes Yes No
CentOS 7.x (64-bit) No Yes Yes No
Red Hat Enterprise Linux 6.x (32-bit [No Yes Yes No
and 64-bit)

Red Hat Enterprise Linux 7.x (64- No Yes Yes No
bit)

Red Hat Enterprise Linux 8.x (64- No Yes Yes No
bit)

Red Hat Enterprise Linux 9.x (64- No Yes Yes No
bit)

Ubuntu 14.04 LTS (32-bit and 64- No Yes Yes No
bit)

Ubuntu 16.04 LTS (32-bit and 64- No Yes Yes No
bit)

Ubuntu 18.04 LTS (64-bit) No Yes Yes No
Ubuntu 20.04 LTS (64-bit) No Yes Yes No
Ubuntu 22.04 LTS (64-bit) No Yes Yes No

Supported Firmware Interfaces

With Converter Standalone you can perform conversions from BIOS and UEFI| sources.

Converter Standalone preserves the firmware interface during the conversion. You cannot convert BIOS sources to UEFI

destinations and the reverse.

Table 4: Supported Sources Based on Operating System and Firmware Interface

Operating System BIOS 64-Bit UEFI
Windows Server 2012 Yes Yes
Windows 8.1 Yes Yes
Windows Server 2012 R2 Yes Yes
Windows 10 Yes Yes
Windows Server 2016 Yes Yes
Windows Server 2019 Yes Yes
Windows 11 No Yes
Windows Server 2022 Yes Yes
CentOS 6.x Yes Yes
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Operating System BIOS 64-Bit UEFI
CentOS 7.x Yes Yes
Red Hat Enterprise Linux 6.x Yes Yes
Red Hat Enterprise Linux 7.x Yes Yes
Red Hat Enterprise Linux 8.x Yes Yes
Red Hat Enterprise Linux 9.x Yes Yes
Ubuntu Linux 14.04 LTS Yes Yes
Ubuntu Linux 16.04 LTS Yes Yes
Ubuntu Linux 18.04 LTS Yes Yes
Ubuntu Linux 20.04 LTS Yes Yes
Ubuntu Linux 22.04 LTS Yes Yes

Supported Source Types

With Converter Standalone, you can convert remote powered on machines, powered off VMware virtual machines and
Hyper-V Server virtual machines.

Table 5: Supported Sources

Source Type Sources

Powered on machines * Remote Windows physical machines

* Remote Linux physical machines

* Local Windows physical machines

¢ Powered on VMware virtual machines

* Powered on Hyper-V Server virtual machines

* Powered on Amazon EC2 Windows and Linux machines

* Powered on virtual machines running under Red Hat KVM and Nutanix AHV
NOTE
Converter Standalone does not support paravirtualized kernels.

VMware vCenter virtual machines |For information about the interoperability between powered off VMware vCenter virtual machines
and vCenter Converter Standalone, see VMware Product Interoperability Matrices.

VMware virtual machines For information about the interoperability between vCenter Converter Standalone and powered
off hosted and virtual machines, see VMware Product Interoperability Matrices.

Hyper-V Server virtual machines For Hyper-V Server versions distributed with Windows Server 2012, Windows Server 2012 R2,
Windows 10, Windows Server 2016, Windows Server 2019, Windows 11, and Windows Server
2022, powered off virtual machines with the following guest operating systems:

*  Windows Server 2012 (64-bit)

¢ Windows Server 2012 R2 (64-bit)

¢ Windows 10 (64-bit) (except Home editions)

e Windows Server 2016 (64-bit)

* Windows Server 2019 (64-bit)

¢ Windows 11 (64-bit)

¢ Windows Server 2022 (64-bit)

For other Hyper-V Server sources, perform the procedure for powered on source machines.
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Supported Destination Types

With Converter Standalone, you can create virtual machines compatible with VMware hosted and managed products.

Managed Destinations

You can create a virtual machine to use with an unmanaged ESXi host or with an ESXi host that vCenter Server
manages. For information on the compatibility between Converter Standalone and current or earlier versions of ESXi and
vCenter Server, see VMware Product Interoperability Matrices.

Hosted Destinations

You can create a virtual machine for use with or . For information on the interoperability between Converter Standalone
and and , see VMware Product Interoperability Matrices.

Supported Source Disk Types

Converter Standalone supports conversions from master boot record (MBR) and GUID partition table (GPT) disks with
some limitations that depend on the selected data cloning mode.

NOTE
Converter Standalone preserves the partitioning scheme during the conversion. You cannot convert an MBR
source disk to a GPT destination disk and the reverse.

Converter Standalone supports all types of basic and dynamic disks for disk-based conversions except for GPT/MBR
hybrid disks.

Converter Standalone supports source and destination disk drives with 512B (512e and 512n) disk sector size only. 4K
native (4Kn) disk drives are not supported.

Table 6: Supported and Nonsupported Source Volumes and Disks

Source Supported Volumes and Disks Nonsupported Volumes and Disks
Virtual machine * Basic volumes * RAID

* All types of dynamic volumes * GPT/MBR hybrid disks

* Master boot record (MBR) disks * RDM disks

* GUID partition table (GPT) disks
Powered on machine * All types of source volumes that the e RAID

operating system recognizes * GPT/MBR hybrid disks
* GUID partition table (GPT) disks + Linux volumes mounted by Device
* Master boot record (MBR) disks Mapper multipath

Supported Destination Disk Types

Several destination disk types might be available for the selected destination.
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Table 7: Destination Disk Types

Destination

Available Disk Types

VMware vSphere virtual machine

Thick

Copies the entire source disk size to the destination, regafdless of

Thin
For managed destinations that support thin provisioning t
example, if the source disk size is 10 GB, but only 3 GB i
GB.

Managed destinations of virtual machine version 10 and later
support disks with size of up to 62 TB. Earlier virtual machine
versions support disks with size of up to 2 TB.

or other VMware virtual machine

Pre-allocated

rough Gl
used, th

Copies the entire source disk size to the destination, regafdless of

Not pre-allocated
Creates an expanding disk on the destination. For examp
created destination disk is 5 GB but can expand to 20 GB
space on the destination datastore.

Split pre-allocated

e, if the s
Take thi

For disks smaller than 2 TB, splits the source disk into 2 GB sectiol

For disks larger than 2 TB, splits the source disk into 2 TB
Split not pre-allocated
For disks smaller than 2 TB, creates 2 GB sections on the
disk. As the destination disk expands, new 2 GB sections
that of the original source disk.
For disks larger than 2 TB, creates 2 TB sections on the d
As the destination disk expands, new 2 TB sections are c
the original source disk.

Hosted destinations of virtual machines support up to 8 TB disks.
Hosted destinations support disks sizes larger than 2040 GB only
if the Split not pre-allocated disk type is selected.

To support destination virtual disks on FAT file systems, split the source data into 2 GB files.

NOTE

Converter Standalone supports destination disk drives with 512B (512e and 512n) disk sector size only. 4K

native (4Kn) disk drives are not supported.

Change the Default Destination Provisioning Disk Type from Thick to Thin

With Converter Standalone 6.6, you can change the default destination provisioning disk type from thick to thin.

1. Navigate to the $ProgramData%\VMware\VMware vCenter Converter Standalone directory.

2. Open the converter-worker.xml file in a text editor.
3.
4

Restart the worker service for the change to take effect.

Locate the <defaultValues><preferThinDiskType> tag and change its value to true.

This change affects all future conversions until the value is restored to false and the service is restarted.

Supported Security Features

Since Converter Standalone 6.4, security features are preserved during the conversion process of virtual machines.
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When you use Converter Standalone to convert virtual machines, the enabled security features on the source machine
are preserved on the destination machine.

Table 8: List of Supported Security Features

Security Feature Description

UEFI Secure Boot UEFI Secure Boot is a security standard that helps ensure that your PC boots
using only software that is trusted by the PC manufacturer. For certain virtual
machine hardware versions and operating systems, you can activate secure
boot just as you can for a physical machine.For more information, see Activate
or Deactivate UEFI Secure Boot for a Virtual Machine in the vSphere Security
documentation.

Virtualization-based Security Microsoft VBS, a feature introduced in Windows 10 and Windows Server
2016 operating systems, uses hardware and software virtualization to
enhance system security by creating an isolated, hypervisor-restricted,
specialized subsystem. For more information, see Securing Windows Guest
Operating Systems with Virtualization-based Security in the vSphere Security
documentation.

Support for IPv6 in Converter Standalone
Converter Standalone supports both IPv4 and IPv6 Internet protocols with several limitations.

Internet Protocol version 6 (IPv6 or IPng) is the successor to Internet Protocol version 4 (IPv4), which is the currently used
protocol for assigning IP addresses to computers on the Internet. IPv6 was adopted to overcome the expected exhaustion
of IPv4 addresses.

IPv4 uses 32-bit addresses and IPv6 uses 128-bit addresses. IPv6 addresses can have different formats or notations.
e 1040:0:0:0:0:0:0:1

e 1040:1

e 21DA:00D3:0010:2F3B:02AA:00FF:FE28:9C5A

¢ [2001:0db8:85a3:08d3:1319:8a2e:0370:7344]:443

Converter Standalone supports all IPv6 notations for all components of the system.

* Converter Standalone installer

e Converter Standalone client

¢ Converter Standalone agent

¢ All destinations supported in Converter Standalone

While providing higher security level and much larger address space, IPv6 brings about some compatibility tasks that
have not been resolved yet. For example, IPv4-only nodes cannot communicate directly with IPv6 nodes and need
additional routing, which makes the end-to-end support of mixed IPv4 and IPv6 environments precarious.

Screen Resolution Requirements

To display wizards properly, Converter Standalone requires a screen resolution of at least 1024x768 pixels.

Configuring Permissions for vCenter Server Users

To convert virtual machines to vCenter Server machines with Converter Standalone, you must have certain vCenter
Server permissions set at the data center level.
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To start using Converter Standalone, you must set various minimum privileges at the data center level.

Datastore > Allocate space

Datastore > Browse datastore

Host > Local operations > Create virtual machine

Host > Local operations > Delete virtual machine

Host > Local operations > Reconfigure virtual machine

Network > Assign network (required only if you plan to connect the destination virtual machine to a network)
Resource > Assign virtual machine to resource pool

Virtual machine > Configuration

Virtual machine > Interaction > Power On (required only if you choose to power on the destination virtual machine
after conversion)

Virtual machine > Inventory
Virtual machine > Provisioning > Allow disk access
Virtual machine > Provisioning > Allow read-only disk access

Converting Linux and powered on Windows machines might require additional vCenter Server privileges.

Virtual machine > Interaction > Configure CD media (required only if you need to boot a converted Linux virtual
machine to install media after the conversion)

Virtual machine > Snapshot management > Create snapshot (required only if you want to synchronize changes
between the source and destination Windows virtual machine)

Virtual machine > Snapshot management > Remove Snapshot (required only if you want to synchronize changes
between the source and destination Windows virtual machine)

For more information about setting permissions, see vSphere Permissions and User Management Tasks.

TCP/IP and UDP Port Requirements for Conversion

To enable conversion, the Converter Standalone server and client must be able to send data to each other, to remote
machines, and to vCenter Server. Also, the source and destination hosts must receive data from each other. Designated
ports are reserved for this communication.

If any of these ports is blocked, the corresponding conversion task fails.

NOTE

If you are using non-default ports to connect to a remote source machine, an ESXi host, vCenter Server,
or Converter Standalone server, you can enter a value for the port after the IP address or the FQDN of the
respective machine.

For IPv4, enter FODN-or-IP address:port number.

For IPv6, enter FODN: port numberor [IP address]:port number .

Ports Used When Converting a Powered On Machine Running Windows

Table 9: Ports Required During Windows P2V contains a list of the ports that must be open during the conversion of
powered on source machines running Windows.
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Table 9: Ports Required During Windows P2V

Communication
Communication Paths Ports Notes
Converter Standalone server to TCP - 445, 139, 9089 | If the source computer uses NetBIOS, port 445 is not required. If
powered on source machine UDP - 137, 138 NetBIOS is not being used, ports 137, 138, and 139 are not required.
When in doubt, make sure that none of the ports are blocked.
NOTE
Unless you have installed Converter Standalone server
or agent on the source computer, the account used
for authentication to the source computer must have
a password, the source computer must have network
file sharing enabled, and it cannot be using Simple File
Sharing.
Converter Standalone server to TCP - 443 Required only if the conversion destination is vCenter Server.
vCenter Server
Converter Standalone client to vCenter | TCP - 443 Required only if the Converter Standalone server and client
Server components are on different machines.
Converter Standalone server to the TCP - 902 Converter server always requires access to ESXi at port 902.
destination ESXi
Powered on source machine to ESXi | TCP - 443, 902 If the conversion destination is vCenter Server, only port 902 is
required.
If the proxy mode feature is on, port 902 is not required.

Ports Used When Converting a Powered On Machine Running Linux

Table 10: Ports Required During Linux P2V contains a list of the ports that must be open during the conversion of
powered on source machines running Linux.

Table 10: Ports Required During Linux P2V

machine

Communication Paths TCP Ports Notes

Converter Standalone server to powered on |22 Used to establish an SSH connection between the Converter

source machine Standalone server and the source machine.

Converter Standalone client to Converter 443 Required only if the Converter Standalone server and client components

Standalone server are on different machines.

Converter Standalone server to vCenter 443 Required only if the conversion destination is a vCenter Server.

Server

Converter Standalone server to ESXi host 443, 902 If the ESXi host is managed by a vCenter Server, port 902 is required.

version 7.x or earlier If the ESXi host is not managed by a vCenter Server, both ports are
required.

Converter Standalone server to ESXi host 443

version 8.0 or later

Converter Standalone server to helper virtual (443
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Communication Paths TCP Ports Notes
Helper virtual machine to powered on source |22 Used to establish an SSH connection between the helper virtual
machine machine and the source machine. By default, the IP address of the

helper virtual machine is assigned by DHCP. If no DHCP server is
available on the destination network, you must manually assign the
helper virtual machine an IP address.

Ports Used When Converting Virtual Machine Sources

Table 11: Ports Required During V2V contains a list of the ports that must be open during the conversion of virtual
machines.

Table 11: Ports Required During V2V

Communication

Communication Paths Notes
Ports
Converter Standalone server to Fileshare |[TCP - 445, 139 Required only for standalone virtual machine sources or
path UDP - 137, 138 destinations. If the computer hosting the source or destination path

uses NetBIOS, port 445 is not required. If NetBIOS is not being
used, ports 137, 138, and 139 are not required. When in doubt,
make sure that none of the ports are blocked.

Converter Standalone client to Converter |[TCP - 443 Required only if the Converter Standalone server and client

Standalone server components are on different machines.

Converter Standalone server to vCenter TCP - 443 Required only if the conversion destination is a vCenter Server.

Server

Converter Standalone server to ESXi TCP -443, 902 If the conversion destination is a vCenter Server, only port 902 is
required.

Requirements for Remote Hot Cloning of Windows Operating Systems

To avoid problems related to permissions and network access, ensure that simple file sharing is turned off and that
Windows Firewall does not block file and printer sharing. Also, to access file and printer sharing ports, you might need to
change the scope of the IP addresses that the firewall allows.

To ensure successful remote hot cloning of Windows platforms, verify the following conditions on the source machine
before you start the application:

* Ensure that simple file sharing is turned off.

¢ Ensure that Windows Firewall is not blocking file and printer sharing.

e If you are running Windows 8 or later on the source machine, turn off Remote UAC. For more details, see
Prerequisites for Converting a Powered On Windows Machine.

You must allow incoming file share connections in the following situations:

* When you use the machine to host standalone images.
*  When you use the machine as a standalone destination.
¢ When you hot clone the machine remotely.

For Windows Vista and later, you must either use an administrator account for Converter Standalone when logging to the
source machine, or deactivate UAC on the source machine.

To activate customization of the guest operating system, install Microsoft Sysprep files on the machine where Converter
Standalone server is running.
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Ensure that Windows Firewall Does Not Block File and Printer Sharing

If Converter Standalone fails to connect to a remote Windows machine and issues a bad username/password error
message, ensure that file and printer sharing is not blocked by Windows Firewall.

1. Select Start > Settings > Control Panel > Administrative Tools > Local Security Policy.

2. In the Security Settings list on the left, select Local Policies > Security Options.

3. In the policies list on the right, select Network access: Sharing and Security model for local accounts.
4. Verify that Classic — local users authenticate as themselves is selected.

For troubleshooting information about file and printer sharing, search the Microsoft TechNet Web site.

For information about setting file and printer sharing on other Windows systems, see the documentation for your system.

Conversion Limitations

When you are aware of the conversion limitations of Converter Standalone, you might be able to avoid conversion and
post-conversion problems, and handle them more easily.

Conversion Limitations for Powered On Machines

When you convert a powered on machine, some conversion features might not be available for certain source operating
systems.

Table 12: Limitations for Powered On Machine Conversion

Source Operating System Limitations

Windows * When you convert UEFI sources, Converter Standalone does not copy any UEFI variables to
the destination.

* Synchronization is supported only for volume-based cloning at the block level.
* If the file system is ReFS, changing the cluster size during a conversion operation is not
supported.

Linux * Only volume-based cloning at the file level is supported.

* Only managed destinations are supported.

* Converting powered on Linux machines is supported only if the source operating system
uses GRUB boot loader. Alternative boot loaders, such as LILO and LOADLIN, and additional
software that alters the GRUB configuration or boot process, such as Trusted Boot, are not
supported.

*  When you convert UEFI sources, Converter Standalone copies only the current UEFI boot
entry option to the destination.

Linux source.
* Installing VMware Tools on Linux guest operating systems is not supported.
* Converting volumes that are formatted with ext 4 file system, where the Linux machine is

systems, does not preserve the file system. The volumes of the destination machine are
formatted with ext 3 file system.

* When converting powered on Linux machines that are running Red Hat Enterprise Linux 6.0
and later minor versions or CentOS 6.0 and later minor versions, key based authentication is
not supported. Instead, you can use password-based authentication.

* Simultaneous cloning of multiple disks and volumes is supported only when converting a virtual

running Red Hat Enterprise Linux 6.0 and later minor versions or Ubuntu Linux 14.04 operating
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Conversion Limitations for Virtual Machines
Certain limitations exist when you convert a virtual machine.

You must power off source virtual machines before you convert them. You can convert running virtual machines if you
follow the procedure for converting powered on machines.

For volume-based conversions of virtual machine sources that run Windows 8 or Windows Server 2012, Converter
Standalone does not preserve storage pools on the destination.

For volume-based conversions of UEFI sources, Converter Standalone does not preserve the UEFI settings. The UEFI
settings are preserved during disk-based conversions.

When you convert a virtual machine with snapshots, the snapshots are not transferred to the destination virtual machine.

For volume-based conversions of powered-off virtual machine sources at file level, the Converter Standalone server host
operating system must support the file system of the source volume. For example, when the Converter Standalone is
running on Windows Server 2008, you cannot convert source volumes with ReFS.

Certain limitations are applicable when you convert Linux virtual machine sources.

* Only disk-based cloning is supported for Linux guest operating systems.
* Configuration or customization is not supported for Linux guest operating systems.
* Installing VMware Tools is not supported on Linux guest operating systems.

Limitations Related to Creating Snapshots of Windows Sources

Converter Standalone uses VSS snapshots to save the state of source volumes during hot cloning of physical and virtual
machines that run Windows. VSS snapshots are also used to synchronize the destination virtual machine with the source
machine after the initial conversion. Some of the VSS-related issues are inherited in Converter Standalone and can
prevent the proper completion of your conversion tasks.

Read the limitations listed in Table 13: VSS Snapshotting Limitations before you initiate a conversion task.

If your conversion task fails with an VSS-related error message, you can check the table for possible reasons and
workarounds.

Table 13: VSS Snapshotting Limitations

VSS Limitations Error Messages Workarounds

For all operating systems that There is no workaround for this

support volume-based cloning, you limitation.

need at least one NTFS volume for

VSS to work.

VSS under Windows Vista and later Deselect all FAT and FAT32 volumes

does not support FAT and FAT32. on the View/Edit Options page of the
vCenter Converter wizards.

VSS under Windows Server 2008 Failed to create VSS snapshot e Format all unformatted or

does not Support unformatted or of source volume. Error Unrecognized volumes and try

unrecognized volumes. code :2147754764 (0x8004230C) the conversion again.

* Deselect all unformatted or
unrecognized volumes while
setting up the conversion task
in the Data to copy pane of the
View/Edit Options page.
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VSS Limitations Error Messages Workarounds
If the space in the VSS snapshot Failed to create VSS snapshot Clean up the source volumes,
storage area is not enough for VSS of source volume. Error code: especially the system volume and all
to create a snapshot, the conversion 2147754783 (0x8004231F) NTFS volumes, and try to convert the
fails. source again.
Importing powered-on Hyper-V Failed to create VSS snapshot 1. Set the starting mode for
sources fails if the following two VSS | ©f source volume. Error code: Microsoft Software Shadow
services are not started or are not 2147754758 (0x80042306) Copy Provider Service and
: Volume Shadow Copy Service to
operating properly on the source
P . I g propefly ! Automatic.

machine: 2. Restart the source machine and
* Microsoft Software Shadow Copy ' trv cloning it aqain

Provider Service Y g 1t again.
* Volume Shadow Copy Service

Installing and Uninstalling Converter Standalone
You can install Converter Standalone on a physical or a virtual machine. You can also modify or repair a Converter
Standalone installation.

The Local setup installs the Converter Standalone server, Converter Standalone agent, and Converter Standalone client
for local use.

NOTE
Local installation of Converter Standalone complies with the following security restrictions:

» After the initial setup, the use of an administrator account requires physical access to the product.
* You can manage Converter Standalone only from the machine where it is installed.

During the client-server installation, you can select the Converter Standalone components that you want to install on your
system. You can also choose to join the Customer Experience Improvement Program. See Configuring the Customer
Experience Improvement Program

When you install the Converter Standalone server and Remote access, the local machine becomes a server for
conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter
Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion

jobs locally.

If you install only Converter Standalone client, you can connect to a remote Converter Standalone server. You can then
use the remote machine to convert hosted virtual machines, managed virtual machines, or remote physical machines.

Perform a Local Installation on Windows

You can install Converter Standalone on a physical or a virtual machine. The local setup installs the Converter Standalone
server, Converter Standalone agent, and Converter Standalone client for local use.

Verify that your system meets the Converter Standalone system requirements.

Verify that you have Administrator privileges.
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If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.

If you install Converter Standalone in local mode, you can create and manage conversion tasks only from the machine on
which you installed the application. During the installation you can choose to join the Customer Experience Improvement
Program. See Configuring the Customer Experience Improvement Program.

1. Log in to the Broadcom Support Portal and download the latest version of Converter Standalone.

2. In the folder that contains the installer file you downloaded, double-click the vMware-converter-6.6.x-
<xxxxx>.exe file, where <xxxxx> is the number of the build.

3. Follow the prompts till the End-User License Agreement page appears.
4. Select | agree to the terms in the License agreement and click Next.

5. On the Destination Folder page, select the location to install Converter Standalone and click Next.
The default location is C: \Program Files\VMware\VMware vCenter Converter Standalone.

6. On the Setup Type page, select Local installation and click Next.

7. Optional: On the User Experience Setting page, you can select the check box to join the Customer Experience
Improvement Program, and click Next.

NOTE
If you do not want to join the Customer Experience Improvement Program, deselect the check box instead.

8. On the Ready to Install page, click Install.

9. Optional: On the Installation Completed page, deselect Run VMware vCenter Converter Standalone Client now if
you want to start the application later.

10. On the Installation Completed page, click Finish.
A prompt might ask you to restart your system.

Converter Standalone is installed on the local machine and is ready for use.
You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Perform a Client-Server Installation in Windows
Perform a client-server installation so that you can create and manage conversion tasks remotely.
Verify that your system meets the Converter Standalone system requirements.
Verify that you have Administrator privileges.
If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.

During the client-server installation, you can select the Converter Standalone components that you want to install on your
system. You can also choose to join the Customer Experience Improvement Program. See Configuring the Customer
Experience Improvement Program

1. Log in to the Broadcom Support Portal and download the latest version of Converter Standalone.

2. In the folder that contains the installer file you downloaded, double-click the VMware-converter-6.6.x-
<xxxxx>.exe file, where <xxxxx> is the number of the build.

3. Follow the prompts till the End-User License Agreement page appears.
4. Select | agree to the terms in the License agreement and click Next.

5. On the Destination Folder page, select the location to install Converter Standalone and click Next.
The default location is C: \Program Files\VMware\VMware vCenter Converter Standalone.
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6. On the Setup Type page, select Client-Server installation (advanced) and click Next.

7. On the Custom Setup page, select the components that you want to install and click Next.
Option Description

Converter server Converter Standalone server manages the conversion tasks. It
handles the communication between the Converter Standalone
clients and Converter Standalone agents. You cannot install
Converter server alone. You must install Converter Standalone
server together with Remote access or with the Converter
Standalone client, or with both.

Remote access If you install Remote access, local and multiple remote
Converter Standalone clients can connect to the local Converter
Standalone server. With Remote access you can create and
manage conversion tasks remotely. For remote access, you
must perform a client-server installation.

Converter agent Install Converter Standalone agent so that the local machine
can be a source machine for conversions.

Converter client If you install only Converter Standalone client, you can connect
to a remote Converter Standalone server. You can then use the
remote machine to convert hosted virtual machines, managed
virtual machines, or remote physical machines.

When you install the Converter Standalone server and Remote access, the local machine becomes a server for
conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter
Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion
jobs locally.

8. Optional: If you decided to install Remote access or Converter Standalone agent, modify the Web service ports on the
Port Settings page.

* Type the HTTPS port service number.
* Type the HTTP port service number.
* Type the Agent port service number.

9. Optional: On the User Experience Setting page, you can select the check box to join the Customer Experience
Improvement Program, and click Next

NOTE
If you do not want to join the Customer Experience Improvement Program, deselect the check box instead.

10. On the Ready to Install page, click Install.

11. Optional: If you installed the Converter Standalone client, deselect Run Converter Standalone Client now to
complete the installation without starting the application at this time.

12. On the Installation Completed page, click Finish.
A prompt might ask you to restart your system.
The selected Converter Standalone components are installed on the local machine and are ready for use.

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Perform a Command-Line Installation in Windows

You can install Converter Standalone from the Command Prompt or by writing a Windows batch file (.bat) to automate
the installation process.
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Verify that your system meets the Converter Standalone system requirements.

Verify that you have Administrator privileges.

If you have an earlier version of Converter Standalone agent on the system, uninstall Converter Standalone agent.
1. Log in to the Broadcom Support Portal and download the latest version of Converter Standalone.

2. Open a Command Prompt window.

3. Atthe command line, navigate to the local directory to which you downloaded the installer.

4

To install Converter Standalone silently with the log file written to the temp directory, enter:
VMware-converter—-6.6.x-<build>.exe /s /v"/gn ADDLOCAL=ALL /l*v $TEMP%\vmconvservermsi.log
VMCE_ENABLE TELEMETRY=true" Where VMware-converter-6.6.x-<build>.exe is the full installer filename.

For more command-line options, see Command-Line Options for Windows Installation.

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Command-Line Options for Windows Installation

You can use the command-line installation options when you install Converter Standalone from the Command Prompt in
Windows or by writing a Windows batch file (.bat).

Table 14: Command-Line Options

Option Action

/s Does not display the Windows Installer version check.
/v"params" Passes parameters to the msiexec. exe file.

/an Runs the msi command in silent mode.

/qb Runs the msi command in basic mode.

/qf Runs the msi command in full mode.

/1*v Logfile Records login information in the file provided in Logfile.
/x Uninstalls vCenter Converter Standalone.
ADDLOCAL="ALL" Installs full package. The parameter is case-sensitive.
PROPERTY=property value Sets the value of a property to property value.
VMCE HTTP PORT Sets the HTTP port. The default is 80. Remote machines

connect to the server through this port to download the Converter
Standalone client.

VMCE_HTTPS PORT Set the HTTPS port. The default is 443. Remote Converter
Standalone clients connect to this port on the server and submit
conversion tasks.

VMCE_AGENT PORT Sets an Agent port. The default is 9089. Remote Converter
Standalone servers connect to this port to convert this machine.

VMCE ENABLE TELEMETRY Controls whether to join the Customer Experience Improvement
Program.
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Modify Converter Standalone in Windows

To change the installed Converter Standalone agent or the communication ports for the Converter Standalone
components, you must modify the Converter Standalone installation.

Verify that you have Administrator privileges.

Close the Converter Standalone application before you start the installer wizard.

1. To start the Converter Standalone installer, perform one of the following actions:

* Go to the folder that contains the installer file and double-click the VMware-converter-6.6.x-<xxxxx>.exe
file, where <xxxxx> is the number of the build. Check the number of the build to see if it matches the build you

installed.

* Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click

Change.

2. On the Welcome page of the installer wizard, click Next.

3. On the Program Maintenance page, select Modify and click Next.

4. On the Custom Setup page, select the components that you want to install and click Next.

Option

Description

Converter server

Converter Standalone server manages the conversion tasks. It
handles the communication between the Converter Standalone
clients and Converter Standalone agents. You cannot install
Converter server alone. You must install Converter Standalone
server together with Remote access or with the Converter
Standalone client, or with both.

Remote access

If you install Remote access, local and multiple remote
Converter Standalone clients can connect to the local Converter
Standalone server. With Remote access you can create and
manage conversion tasks remotely. For remote access, you
must perform a client-server installation.

Converter agent

Install Converter Standalone agent so that the local machine
can be a source machine for conversions.

Converter client

If you install only Converter Standalone client, you can connect
to a remote Converter Standalone server. You can then use the
remote machine to convert hosted virtual machines, managed
virtual machines, or remote physical machines.

When you install the Converter Standalone server and Remote access, the local machine becomes a server for
conversions, which you can manage remotely. When you install the Converter Standalone server and the Converter
Standalone client, you can use the local machine to access remote Converter Standalone servers or create conversion

jobs locally.

5. Optional: If you decided to install Remote access or Converter Standalone agent, modify the Web service ports on the

Port Settings page.

* Type the HTTPS port service number.
* Type the HTTP port service number.
* Type the Agent port service number.
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6. On the Ready to Modify page, click Install.

7. Optional: If you installed the Converter Standalone client, deselect Run Converter Standalone Client now to
complete the installation without starting the application at this time.

8. On the Installation Completed page, click Finish.
A prompt might ask you to restart your system.

The selected Converter Standalone components are installed on the local machine and are ready for use.

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Repair Converter Standalone in Windows

You can repair the Converter Standalone installation to check for and reinstall the Converter Standalone client or
Converter Standalone agent.

Verify that you have Administrator privileges.
Close the Converter Standalone application before you start the installer wizard.
1. To start the Converter Standalone installer, perform one of the following actions:

* Go to the folder that contains the installer file and double-click the VMware-converter-6.6.x-<xxxxx>.exe
file, where <xxxxx> is the number of the build. Check the number of the build to see if it matches the build you
installed.

* Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click
Change.

On the Welcome page of the installer wizard, click Next.
On the Program Maintenance page, select Repair and click Next.

On the Ready to Repair page, click Install.

o > 0NN

On the Installation Completed page, click Finish.
A prompt might ask you to restart your system.

You can use Converter Standalone to convert physical or virtual machine sources to virtual machine destinations.

Uninstall Converter Standalone in Windows

You can uninstall Converter Standalone by using the Microsoft Windows Add or Remove Programs utility from the Control
Panel.

Verify that you have Administrator privileges.

Close the Converter Standalone application before you start the installer wizard.

Alternatively, you can uninstall Converter Standalone by using the VMware vCenter Converter Standalone installer wizard.
1. To start the Converter Standalone installer, perform one of the following actions:

* Go to the folder that contains the installer file and double-click the VMware-converter-6.6.x-<xxxxx>.exe
file, where <xxxxx> is the number of the build. Check the number of the build to see if it matches the build you
installed.

* Select Add or Remove Programs from Control Panel, select Converter Standalone from the list, and click
Change.
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On the Welcome page of the installer wizard, click Next.
On the Program Maintenance page, select Remove and click Next.
On the Ready to Remove page, click Remove.

On the Installation Completed page, click Finish.
A prompt might ask you to restart your system.

Connect to a Remote Converter Standalone Server

You can use the Converter Standalone client to connect to a Converter Standalone server installed on a remote machine.

Ensure that the Converter Standalone server and agent are installed on the remote machine.

1.
2.

Start Converter Standalone.

Follow the procedure that is applicable for your installation type.

Option Action

Local installation 1. Select Administration > Connect to another server.

2. On the Converter Standalone login page, select Enter the
IP address or host name of the Converter Standalone
server.

3. Provide the IP address and Administrator credentials, and
click Login.

Client-server installation with remote access 1. On the Converter Standalone login page, select Enter the
IP address or host name of the Converter Standalone
server.

2. Provide the IP address and Administrator credentials, and
click Login.

You can now use the remote Converter Standalone server to set up and manage conversion tasks.
Enable TLS 1.0 and TLS 1.1 Protocols in vCenter Converter Standalone

By default vCenter Converter Standalone 6.6 supports only TLS 1.2 security protocol. If needed, you can enable the TLS
1.0 and TLS 1.1 protocols manually.

1.
2.

4.

Navigate to the $ProgramData%\VMware\VMware vCenter Converter Standalone directory.
Open the converter-client.xml, converter-server.xml, converter-worker.xml, and converter-
agent.xml files in a text editor.
The converter-client.xml file is located in the $ProgramFiles (x86) $\VMware\VMware vCenter
Converter Standalone folder.
Change the value of the <ss10ptions> tag for each of the files.
a) Locate the <ss10Options> tag in the file and to enable the TLS 1.1 protocol, change value of the tag from
12342272010 391858176.

NOTE

If you change the value to 56313856, you enable the TLS 1.0, TLS 1.1, and TLS 1.2 security protocols.
b) Save the changes to the file.

Restart the Converter Standalone services for the changes to take effect.

NOTE
If you install Converter Agent on a remote machine, you must repeat this procedure by using the
converter-agent.xml file on the remote machine.
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Configuring the Customer Experience Improvement Program

When you choose to participate in the Customer Experience Improvement Program (CEIP), VMware receives anonymous
information to improve the quality, reliability, and functionality of VMware products and services.

Categories of Information That VMware Receives
This product participates in VMware's Customer Experience Improvement Program ("CEIP").

Details regarding the data collected through CEIP and the purposes for which it is used by VMware are set forth at the
Trust & Assurance Center at https://www.broadcom.com/company/legal/privacy/data-usage-programs/ceip.

To join or leave the CEIP for this product, please see Join or Leave the Customer Experience Improvement Program.

Join or Leave the Customer Experience Improvement Program
You can choose to join the Customer Experience Improvement Program (CEIP), or leave the CEIP at any time.

NOTE
You can join the CEIP during the installation of Converter Standalone.

1. From the Administration menu on the toolbar, select Customer Experience Improvement Program.
2. Select the check box to activate CEIP or deselect the check box to deactivate the program.

3. Click OK.

Convert a Physical or Virtual Machine

You can create a conversion job to convert a physical or virtual machine to a variety of destinations. You can convert
powered on physical machines, VMware virtual machines, and Hyper-V Server virtual machines into VMware standalone
virtual machines or virtual machines that vCenter Server manages.

The approach you take for creating the conversion job is determined by the type of source and the type of destination that
you select.

Source type
A powered on physical or virtual machine, a vSphere virtual machine running on an ESXi host, or a standalone virtual
machine.

Standalone virtual machines include VMware virtual machines, such as machines.
For a complete list of supported source types and product versions, see Supported Source Types.

Destination type
ESXi host, ESXi host that vCenter Server manages, or a VMware standalone virtual machine.

For a complete list of supported destination types and product versions, see Supported Destination Types.

Start the Wizard for a Conversion
The Conversion wizard guides you through the steps of creating a conversion job.
1. Start the Converter Standalone application.

2. Click Convert machine in the application menu.

The Conversion wizard opens on the Source System page.

You can now select the source machine type to convert.
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Select a Source Machine to Convert

You can select from several source options for the type of machine to convert.

Before you select a source machine to convert, verify that it is listed in the list of supported source types. See Supported
Source Types.

Prerequisites for Converting a Powered On Windows Machine

Before you continue with the conversion, you must prepare the source Windows machine.

Make sure that the Windows version installed on the powered on machine is supported. For a list of supported

operating systems, see Supported Operating Systems.

Make sure that the Converter Standalone server machine has network access to the Windows source machine.

Turn off firewall applications running on the source machine.

Deactivate simple file sharing on the source Windows machine.

Stop or deactivate anti-virus software running on the source machine.

Turn off User Account Control (UAC) or use local administrator account on the source machine.

If you are running Windows 8 or later on the source machine, turn off Remote UAC.

— If you are logged in as a member of the local Administrators group, you must deactivate the User Account Control:
Use Admin Approval Mode for the built-in Administrator account policy in the Security Options folder of
the Local Group Policy Editor. You must reboot for the changes to take effect.

— If you are logged in as the Administrator, you must deactivate the User Account Control: Turn on Admin
Approval Mode policy in the Security Options folder of the Local Group Policy Editor. You don't need to
reboot for the changes to take effect.

NOTE
The Security Options folderis located in Computer Configuration/Windows Settings/
Security Settings/Local Policies.

Make sure that no other conversion job is using the source you select.

Remove any Converter Standalone 4.x and Converter Standalone 5.x installations manually from the source machine.

Select a Powered On Windows Machine to Convert

You can select a powered on Windows machine to convert. The source machine can be a physical or a virtual machine.

Verify that your Windows machine is prepared for conversion. See Prerequisites for Converting a Powered On Windows
Machine.

1.

On the Source System page of the Conversion wizard, select the Powered on radio button.

2. From the drop-down menu, select a menu item that corresponds to your source machine location.

NOTE
If you have connected a Converter Standalone client to a remote Converter Standalone server, the menu
item This local machine is not available and you can convert the local machine only as a remote machine.

Source Location Action
Local Click This local machine.
Remote Click Remote Windows machine and provide the IP address or

name of the machine and administrator credentials.

The default Converter Standalone Agent port for remote
Windows machines is 9089. If you previously modified the
Converter Standalone Agent port service number, enter

IP Address:Port,where TP Addressis the IP address
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Source Location Action

of the remote Windows machine and port is the Agent port
service number.

NOTE

You can provide the user name in the domain
\user credentials format. Alternatively, you can
enter a user name without a domain name and
Converter Standalone will attempt to log you in to
the remote machine by using the machine\user
format.

3. Optional: Click View source details to see the hardware and software information about the source machine.
4. Click Next.

If you convert a remote machine and the Converter Standalone agent is not already installed on the source machine,
a dialog box prompts you to confirm the installation and select an uninstallation method for the Converter Standalone
agent.

Optional: Select the uninstallation procedure for Converter Standalone agent and click Yes.

Converter Standalone agent is installed on the source machine.

Converter Standalone agent prepares the source machine for conversion.

On the Destination System page, you can select the destination type for the new virtual machine.

Select a Powered On Linux Machine to Convert

You can select a powered on Linux machine to convert. The source machine can be a physical or virtual machine.

Before you continue with the conversion, you must prepare the source Linux machine.

Enable SSH on the source Linux machine.

Make sure that you use the root account or account with sudo privileges without password prompt for all commands to
convert a powered on Linux machine.

Make sure that the Converter Standalone server machine has network access to the Linux source machine.
Make sure that no other conversion job is using the source you select.

You can convert powered on machines that run Linux only if the source operating system uses GRUB boot loader on
the source machine. Alternative boot loaders, such as LILO and LOADLIN, and additional software that alters the GRUB
configuration or boot process, such as Trusted Boot, are not supported.

1.

On the Source System page of the Conversion wizard, select the Powered on radio button.

2. Select Remote Linux machine from the drop down menu.

3. Provide the IP address or DNS name and select authentication method. Provide the IP address or DNS name and root

credentials for the Linux machine you want to convert.

The default SSH daemon port for remote Linux machines is 22. If you previously modified the SSH daemon port
service number, enter IP_Address: Port ,where IP_Address is the IP address of the remote Linux machine and
Port is the SSH daemon port service number.

Option Description

Password Enter the root credentials for the Linux machine you want to
convert.

Private key file Select the private key file and enter the passphrase.
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4. Click Next.

Converter Standalone connects to the powered on Linux machine and prepares it for conversion.
On the Destination System page, you can select the destination type for the new virtual machine.

Customize a Path for Temporary Files During Linux Queries

You can provide a path to a folder where the vimware-sysinfo files are extracted and executed during a Linux migration.

If the Linux policy does not allow running code as a privileged user from the /tmp directory, you can configure Converter
Standalone to place its temporary files in another directory during Linux conversions.

1. Navigate to the $ProgramData%\VMware\VMware vCenter Converter Standalone directory.
2. Open the converter-worker.xmlfile in a text editor.

3. Locate and uncomment the <sysinfoTmpRoot> tag.

4. Change the value of the <sysinfoTmpRoot> tag to a proper directory and save the change.

5

. Restart the worker service for the change to take effect.

This change affects all future Linux conversions until the value is restored and the service is restarted.

Select an ESXi or vCenter Server Virtual Machine to Convert

You can convert a powered off virtual machine that is located on an ESXi host, or on an ESXi host managed by vCenter
Server.

If the source machine that you want to convert resides on a VMware DRS cluster that vCenter Server manages, set
VMware DRS Power Management (DPM) to manual so that DPM does not power off the ESXi hosts used by Converter
Standalone. When the conversion process completes, restore DPM to its original settings. For information about how to
change DPM settings, see vSphere Resource Management.

Power off the source machine before the conversion.

You cannot convert a running or suspended virtual machine by using this procedure. For powered on virtual machines,
use the procedures for powered on source machines.

If you connect to a vCenter Server that is part of an environment that contains multiple vCenter Server instances,
Converter Standalone displays only ESXi hosts managed directly by the currently connected vCenter Server.

1. On the Source System page of the Conversion wizard, select the Powered off radio button and then select VMware
Infrastructure virtual machine from the Select source type drop-down menu.

2. Provide the IP address or host name and credentials for authentication with the ESXi host or the vCenter Server, and
click Next.
The Source Machine page appears, displaying the host name or IP address and the inventory of the ESXi host or the

vCenter Server.

On the Source Machine page of the Conversion wizard, you can browse the virtual infrastructure inventory and select the
virtual machine to convert.

Specify the vCenter Server Virtual Machine to Convert

If you choose to convert a virtual machine managed by vCenter Server or an ESXi host, you must browse the inventory to
locate the source virtual machine.
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On the Source System page of the Conversion wizard, select VMware Infrastructure virtual machine as the conversion
source and click Next to proceed to the Source Machine page.

1.

4.
5.
6.

Optional: If you are connected to a vCenter Server, select a virtual machine view from the Specify machine with
drop-down menu.

Option Description

Hosts and Clusters The Inventory tree pane provides a view of hosts, clusters,
resource pools, and vApps. If you select a host managed by a
cluster, you see the full list of virtual machines and templates in
the virtual machine list view. If you select a standalone host or a
cluster, you see only the virtual machines that are not deployed
in the resource pools of that host or cluster.

VMs and Templates The Inventory tree pane provides a view of datacenters and
virtual machine folders.

Optional: If you are connected to a vCenter Server, select an object from the Inventory tree pane.

Option Description
Hosts and Clusters Select cluster, ESXi host, resource pool, or vApp.
VMs and Templates Select datacenter or virtual machine folder.

From the virtual machines list, select the virtual machine you want to convert.

You can search for virtual machines in the virtual machine list by typing one or more letters of their names in the
Search for name with text box. You can clear your search by clicking Clear.

NOTE
You cannot select a virtual machine from an ESXi host that is powered off, connected to another vCenter

Server, or in maintenace mode.
Optional: To refresh the inventory, click Refresh.
Optional: To view more details about a machine, select it and click View source details.

Click Next to proceed to the Destination System page.

On the Destination System page, you can select the destination type for the new virtual machine.

Select a VMware Hosted Virtual Machine to Convert

You can convert a virtual machine created or used in a VMware hosted product, such as , VMware Player, and .

Verify that your source machine is a supported VMware Desktop products virtual machine. For more information, see
Supported Source Types.

If you plan to use a network path to locate the source, verify that the machine where Converter Standalone server runs
has access to that network path.

Power off the source machine before the conversion.

1.

On the Source System page of the Conversion wizard, select the Powered off radio button and then select VMware
Workstation or other VMware virtual machine from the Select source type drop-down menu.

2. Locate the virtual machine source.

* If you are connected to a remote Converter Standalone server, provide a network path to the source virtual
machine file (. vmx) in the Virtual machine file text box. For example, \\server\virtual machines
\virtual machine.vmx.

* If you are connected to a local Converter Standalone server, provide a network path or a local path to the . vmx file.

By default, only VMware virtual machine * . vmx files are displayed.
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3. If you are connected to a remote Converter Standalone server, type user credentials for accessing the source virtual
machine.

You do not have to provide user credentials if you are connected to a local Converter Standalone server. In such
cases, Converter Standalone uses the Windows credentials to connect to the source machine.

4. Optional: To view more information about the selected source, click View source details.
5. Click Next to proceed to the Destination System page.

On the Destination System page, you can select the destination type for the new virtual machine.

Select a Hyper-V Server Virtual Machine to Convert
You can convert virtual machines that Hyper-V Server manages.
Power off the source Hyper-V virtual machine.

1. On the Source System page, select the Powered off radio button and then select Hyper-V Server from the Select
source type drop-down menu.

2. Provide the IP address or DNS name and administrative credentials to authenticate with the Hyper-V Server and click
Next.

If Converter Standalone agent is not already installed on the Hyper-V Server, a dialog box appears. In it, you confirm
the installation of Converter Standalone agent.

3. Optional: Select an uninstallation procedure for Converter Standalone agent and click Yes.

Converter Standalone agent is installed on the source Hyper-V Server.

On the Source Machine page, browse the Hyper-V Server inventory to locate the source virtual machine to convert.
Specify the Hyper-V Server Virtual Machine to Convert

If you choose to convert a virtual machine managed by a Hyper-V Server, you must browse the inventory to locate the
source virtual machine.

On the Source System page, select Hyper-V Server as the source type and navigate to the Source Machine page.

1. On the Source Machine page, select the virtual machine you want to convert.

You can search for virtual machines in the inventory by typing one or more letters of their names in the Search for
name with text box. You can clear your search by clicking Clear.

NOTE

You can select only powered off virtual machines. To convert a running machine, on the Source System page
select Powered on machine as the source type. To convert a suspended machine, power it off and convert
it as a Hyper-V Server virtual machine, or power it on and convert it as a powered on source.

2. Optional: To refresh the inventory, click Refresh.
3. Optional: To view more details about the virtual machine to convert, click View source details.

4. Click Next to proceed to the Destination System page.

The Converter Standalone agent prepares the Hyper-V source machine for conversion.

On the Destination System page, you can select the destination type for the new virtual machine.

Converting an Amazon EC2 Instance to a VMware Virtual Machine

With Converter Standalone, you can convert Amazon Elastic Compute Cloud (Amazon EC2) Windows and Linux
instances to VMware virtual machines.

55



vCenter Converter Standalone 6.6

You can perform a conversion operation of an Amazon EC2 instance to a VMware virtual machine in the following ways.

* Import the source machine directly to an ESXi host that a vCenter Server instance manages.

* Convert the Amazon EC2 Windows instance to a virtual machine and then manually import the virtual machine to an
ESXi host.

Convert an Amazon EC2 instance to a VMware virtual machine

Since Converter Standalone 6.4, you can convert remote Amazon EC2 Windows and Linux instances that have no direct
access to the destination ESXi host. The vCenter Server instance that manages the ESXi host can be located either on-
premises or in VMware Cloud.

NOTE

The conversion of remote Windows instances without direct access to the destination ESXi host, requires the
use of proxy mode. For more information on conversion of remote Windows machines, see Remote Hot Cloning
of Powered On Source Machines That Are Running Windows. For more information on conversion of remote
Linux machines, see Remote Hot Cloning of Powered On Source Machines That Are Running Linux.

Prerequisites

* Verify that the Amazon EC2 source machine is powered on. Conversion of powered-off virtual machines (VMs) is not
supported.

Prepare the Amazon EC2 Source Machine

* Prepare your Amazon EC2 Windows machine.
a. Inthe AWS console, under Security groups, add a new inbound rule and enable port 9089 for the Converter
Standalone server IP address.
b. Install the Converter Standalone agent in the source machine.
a. Navigate to the folder where Converter Standalone is installed.
By default, Converter Standalone is installed in C: \Program Files (x86)\VMware\VMware vCenter
Converter Standalone.
b. Copy VMware-Converter-Agent.exe to your source machine.
c. Run vMware-Converter—-Agent.exe.
* Prepare your Amazon EC2 Linux machine.
a. Inthe VMware Cloud console, select Open NSX Manager.
b. Navigate to the Networking & Security > Overview tab.
c. Under Default Compute Gateway, view the Source NAT public IP address.
d

In the AWS console, under Security groups, add a new inbound rule and enable port 22 for the Converter
Standalone server IP and Source NAT public IP addresses.

e. If you want to import the Linux machine into VMware Cloud, in the converter-worker.xml configuration file,
change the value of the UseHostIPForWWebSocketTicket property to true and restart the worker service.

In VMware Cloud, ESXi hosts use their IP addresses, instead of Fully Qualified Domain Names (FQDNSs), to
register with vCenter Server.

Prepare the Destination Machine in VMware Cloud

If you are importing your source machine to VMware Cloud, perform the following steps.

1. If you are converting a Windows machine, create a VM with Windows operating system and in the VM, install
Converter Standalone.
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2.

Provide Converter Standalone with network access to the vCenter Server instance and ESXi host in VMware Cloud.
a. Inthe VMware Cloud console, select Open NSX Manager.

Navigate to the Security > Gateway Firewall > Management Gateway tab.

Create a Management Gateway Firewall rule and add the Converter Standalone server IP address to the rule.
Add a new rule that allows network access to your vCenter Server instance and enable the HTTPS service.

Add a new rule that allows network access to your ESXi host and enable the HTTPS and Provisoning and
Remote Control services.

For more information on managing NSX Firewall rules in VMware Cloud, see SDDC Network Administration with NSX
Manager in the VMware Cloud on AWS Networking and Security documentation.

®oo0co

Convert the Amazon EC2 Source Machine to the Destination VMware Virtual Machine

1.

Start the Converter Standalone application.

See Start the Wizard for a Conversion.

Select a remote powered on Linux or Windows machine to convert.

See Select a Source Machine to Convert.

Select a destination for your virtual machine.

If you are importing a remote Windows machine, on the Destination System page of the Conversion wizard,
select the Use proxy mode check box. As a result, the data traffic passes through the Converter Standalone server
machine.

See Select a Destination for the New Virtual Machine.

Configure the virtual hardware resources that the destination virtual machine uses.

See Configure the Hardware of the Destination Virtual Machine.

Configure the guest operating system and enable it to operate in a virtual environment.

See Configure the Software on the Destination Virtual Machine.

Configure the conversion process and select the behavior of the source and destination machine during and after
conversion.

See Configure the Conversion Job.

Check the summary of your conversion job before adding it to the job list.

See Review the Summary and Submit the Conversion Job.

Import an Amazon EC2 Windows Instance to VMware Workstation

You can convert an Amazon EC2 Windows instance to a virtual machine (VM), and then manually import the VM to an
ESXi host.
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Verify that the source Amazon Elastic Compute Cloud (Amazon EC2) Windows instance has a temporary volume that is
large enough to accommodate the image of your Amazon EC2 Windows instance. This temporary drive must be excluded
from the conversion.

1. Install Converter Standalone on the Amazon EC2 Windows instance that you want to convert.

2. Create a conversion task to import the Amazon EC2 Windows instance as a destination.

a) Start Converter Standalone on the Amazon EC2 Windows instance.

b) Click Convert Machine in the application menu to start the Conversion wizard.

c) On the Source System page, select Powered on from the Select source type menu and click This local
machine.

d) Click Next to proceed to the Specify Destination page.

e) On the Destination System page, select VMware Workstation or other VMware virtual machine from the drop-
down menu and select a suitable version from the VMware product list.

f) Click Next to proceed to the Options page.

g) On the Options page, select Data to Copy in the list of options.

h) Deselect the check box in front of the temporary volume to exclude it from the conversion task.

i) Click Next to proceed to the Summary page.

VM files, such as vimx and vmdk files, are created during the conversion.

3. On the temporary volume of the Amazon EC2 Windows instance, locate the VM files that were created during the
conversion.

4. Transfer the VM files to a location that is accessible to your virtual infrastructure and to Converter Standalone. You
have several options to transfer the files:

* Upload the files to a local FTP server using an FTP client that runs inside the Amazon EC2 Windows instance.

* Upload the files from the Amazon EC2 Windows instance to Amazon S3 and download them to a location that is
accessible to your virtual infrastructure and to Converter Standalone.

* Upload the files from the Amazon EC2 Windows instance to Amazon S3 and use Amazon AWS Import/Export
to retrieve the data on a physical storage device. For more information about this procedure, see Amazon Web
Services.

To import the VM image to an ESXi host, follow the procedures described in Select a VMware Hosted Virtual Machine to
Convert and in Select a Managed Destination.

Select a Destination for the New Virtual Machine
When you set up a conversion job, you must select a destination for the new virtual machine.

When you use a VMware DRS cluster as the destination, you must set VMware DRS Power Management (DPM) to
manual. This setting ensures that DPM does not power off the ESXi hosts that Converter Standalone uses. When the
conversion process completes, restore DPM to its original settings. For information about how to change DPM settings,
see vSphere Resource Management.

NOTE
For conversions of powered on source machines that run Linux, the only supported destination is a vSphere
destination.
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Select a Managed Destination
You can convert a virtual machine to use with ESXi or with an ESXi host that vCenter Server manages.

1. On the Destination System page, select VMware Infrastructure virtual machine from the Select destination type
drop-down menu.

2. Provide the IP address or host name and credentials for authentication with the ESXi host or vCenter Server.

3. When you convert a remote machine that has no direct access to the destination ESXi server, select the Use proxy
mode check box.

Proxy mode passes the data traffic through the Converter Standalone server machine.
4. Click Next to proceed to the Destination Virtual Machine page.

On the Destination Virtual Machine page, you can specify the name of the destination virtual machine and select the folder
in which it should reside.

Name the Destination Virtual Machine and Select a Folder

For vSphere destinations, you can select the destination folder and rename the destination virtual machine.

On the Destination System page of the Conversion wizard, select VMware Infrastructure virtual machine as the
destination type.

If you connect to an ESXi host directly, you can view only the list of virtual machines. Therefore, you cannot select a

destination folder.

1. On the Destination Virtual Machine page, select the datacenter to accommodate the destination virtual machine.
If you use folders in your virtual environment to manage groups of virtual machines, you can select a folder to
accommodate the destination virtual machine.

2. In the Name text box, enter a name for the destination virtual machine.

By default, Converter Standalone assigns the source machine name in this text box.
NOTE
Search the list of virtual machines in the datacenter or folder you selected to ensure that the name you

assign to the destination virtual machine does not exist. Virtual machines are filtered as you type. You can
clear your search by clicking Clear.

3. Optional: To refresh the inventory, click Refresh.
4. Click Next to proceed to the Destination Location page.

On the Destination Location page, you can modify the destination environment for the new virtual machine. This
includes selecting a host, resource pool, or cluster to accommodate the destination virtual machine, selecting a datastore
to hold the files of the destination virtual machine, and selecting the virtual hardware version to install on the destination
virtual machine.

Customize the Location of the Destination Virtual Machine

For vSphere destinations, you can select an ESXi host, a resource pool, or a cluster. You can also select a datastore and
the virtual hardware version to be installed on the destination.
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On the Destination Virtual Machine page, name the destination virtual machine. If the destination is a vCenter Server,
select the destination folder.

1. On the Destination Location page of the Conversion wizard, select a datacenter object from the inventory to
accommodate the destination virtual machine.

e Select an ESXi host.
* Select a resource pool.
* Select a cluster.

On the selected cluster, if DRS is not running in the automated mode, you can select an ESXi host that belongs to
the selected cluster from the Host drop-down menu.

2. Optional: From the Datastore drop-down menu, select the datastore to hold the destination virtual machine files.

3. Optional: From the Virtual machine version drop-down menu, select the virtual hardware version for the destination
virtual machine.

The Virtual machine version drop-down menu lists only the virtual hardware versions that are compatible with the
destination location. For more information about virtual machine compatibility, see Hardware Features Available with
Virtual Machine Compatibility Settings in the vSphere Virtual Machine Administration documentation.

4. Click Next to proceed to the Options page.

On the Options page, you can set up the parameters of the conversion task. These settings include data layout, network
settings, and guest operating system customization.

Select a Hosted Destination
You can convert a virtual machine for use with , , or.
If you plan to use a network path to locate the destination, verify that you have access to that network path.

1. On the Destination System page, select VMware Workstation or other VMware virtual machine from the Select
destination type drop-down menu.

2. Select the destination VMware hosted product from the Select VMware product drop-down menu.
3. Provide a name for the destination virtual machine in the Name text box.
4. Specify the location to store the destination virtual machine files.

* If you are connected to a remote Converter Standalone server, provide a network path to the destination directory.
For example, \\server\virtual machines\.

* If you are connected to a local Converter Standalone server, provide a network path or a local path to the
destination directory.

5. Optional: If the destination directory is password-protected, provide valid user credentials.

You do not have to provide user credentials if the destination location is on the local storage of the machine where
Converter Standalone server runs.

6. Click Next to proceed to the Options page.

On the Options page, you can set up the parameters of the conversion task. These settings include data layout, network
settings, and guest operating system customization.

Configure the Hardware of the Destination Virtual Machine

You can configure the virtual hardware resources that the destination virtual machine uses.
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Organize the Data to Be Copied on the Destination Machine

Your selected source and destination determine the available data cloning options. For a conversion job, you can copy all
disks to the destination or select the volumes to be copied or to be excluded. For destinations with multiple datastores,
you can select the data location on specific datastores in your virtual environment.

On the Options page of the Conversion wizard, click Data to copy in the options list.

If you selected a source with multiple disks and volumes, you can set Converter to start concurrent data transfers. For
details, see Set the Number of Data Connections per Task.

In the Data to copy pane, select a copy mode from the Data copy type drop-down menu.

Option Description

Copy all disks and maintain layout Results in disk-based cloning. You can preserve the source
disk layout in the destination virtual machine. This option is not
available for powered on source machines.

Select volumes to copy Results in volume-based cloning. Volume-based cloning is
performed at file or block level. You can select the volumes to be
copied to the destination virtual machine. You can also resize and
reorganize the volume layout. This option is available for powered
on source machines that run Windows and Linux, and for all other
supported sources that run Windows.

Linked clone Results in creating a VMware virtual machine that shares the
virtual disk of the source machine. This option is available only for
hosted sources and hosted destinations.

The destination that you select determines the destination disk types that are available to you. To support destination
virtual disks on FAT file systems, divide the source data into 2 GB files. For detailed information about destination virtual
disks types, see Supported Destination Disk Types.

Resize a Volume

To manage disk space on the destination datastore, you can resize the disk volumes before you begin the conversion.
On the Options page of the Conversion wizard, click Data to copy in the options list.
1. From the Data copy type drop-down menu, select Select volumes to copy.

2. In the Destination size column, select an option to specify the size of a destination volume.

Option Description
Maintain size Maintains the original source volume size.
NOTE

If the volume is nearly full, Converter Standalone
allocates a buffer amount and displays a volume
amount greater than the source volume.

Min size Copies only the used space of the source volume.

NOTE

Converter Standalone allocates a buffer amount and
displays a volume amount greater than the source
volume.

Type size in GB Allows you to type a custom size in GB for the destination
volume. The value cannot be smaller than the used space on
the source volume, but can be larger than the total size of the
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Option

Description

source volume. The maximum allowed volume size for the
destination is 999999 GB.

Type size in MB

Allows you to type a custom size in MB for the destination
volume. The value cannot be smaller than the used space on
the source volume, but can be larger than the total size of the
source volume. The maximum allowed volume size for the
destination is 999999 GB.

3. Save your settings.

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.

Click Next

Saves your settings and displays the next page of the
Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Change a Volume Cluster Size

To enhance performance and storage space, you can change the volume cluster size before the conversion. Modifying the
cluster size changes the cloning mode from block level to file level.

On the Options page of the Conversion wizard, click Data to copy in the options list.

Ensure that the source is a Windows machine.

1. From the Data copy type drop-down menu, select Select volumes to copy.

Click Advanced and select the Destination layout tab.

2
3. Select the volume for which you want to change the cluster size.
4

In the Cluster size column, select an option to specify the cluster size of the destination volume.

Option

Description

Default cluster size

Applies a default cluster size to the destination volume.

Keep source cluster size

Preserves the cluster size of the original source volume.

Select a predefined size

Allows you to select a cluster size for the destination volume
from a list of supported values.

In the Copy type column, you can verify that the cloning operation type is set to file level.

5. Save your settings.

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.
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Option Description

Click Next Saves your settings and displays the next page of the
Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Exclude a Source Volume from the Conversion Process

When you choose not to copy a volume, Converter Standalone ignores the deselected volumes during the conversion
process.

On the Options page of the Conversion wizard, click Data to copy in the options list.

The source virtual machine must have more than one volume to be able to deselect existing volumes.

1. From the Data copy type drop-down menu, select Select volumes to copy.

2. Deselect the volumes that you do not want to copy to the destination virtual machine.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

The deselected volumes are ignored during the conversion process and do not appear on the destination virtual machine.

Move a Volume to a Different Virtual Disk

You can add virtual disks to the destination virtual machine and move source volumes in the new disks.
On the Options page of the Conversion wizard, click Data to copy in the options list.

The number of virtual disks you can create depends on the number of volumes that exist on the source virtual machine.
For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to the destination
virtual machine.

You cannot move the system volume where the guest operating system is installed. For example, if your Windows
operating system is installed on C:, you cannot move the C: volume.

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Click Advanced and select the Destination layout tab.

3. Select a volume from the list and click Add disk.
A new virtual disk appears in the Destination layout column.
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4.

Select a source volume and use the Move up or Move down buttons to accommodate the volume in the new virtual
disk.

The partitioning scheme of the first source volume that you move will determine the type of the new virtual disk on the
destination virtual machine.

If you leave the virtual disk empty, Converter Standalone does not create the virtual disk on the destination virtual
machine.

The selected source volume is copied to a new virtual disk on the destination virtual machine.

Select the Destination Datastore for a Source Volume

You can store a disk volume in a datastore different from the one that accommodates the virtual machine configuration file
(. vmx).

On the Options page of the Conversion wizard, click Data to copy in the options list.

You can select the destination datastore for a volume only for managed destinations with more than one datastore.

1.
2.
3.

From the Data copy type drop-down menu, select Select volumes to copy.
Click Advanced and select the Destination layout tab.

Select a volume from the list and click Add disk.
A new virtual disk appears in the Destination layout column.

Select a source volume and use the Move up or Move down buttons to accommodate the volume in the new virtual
disk.

The partitioning scheme of the first source volume that you move will determine the type of the new virtual disk on the
destination virtual machine.

If you leave the virtual disk empty, Converter Standalone does not create the virtual disk on the destination virtual
machine.

Highlight the new virtual disk and select a different datastore from the Destination datastore drop-down menu.

6. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

The virtual disk file (. vmdk) that contains the volume is stored in the selected datastore.
Add a Virtual Disk

You can add additional virtual disks to the destination virtual machine .

You must have more than one volumes on the source machine to be able to add an additional virtual disk.

64



vCenter Converter Standalone 6.6

On the Options page of the Conversion wizard, click Data to copy in the options list.

The number of virtual disks on the destination virtual machine depends on the number of volumes that exist on the source
virtual machine . For example, if you have only one volume on the source virtual machine, you cannot add a virtual disk to
the destination virtual machine.

1. From the Data copy type drop-down menu, select Select volumes to copy.
2. Click Advanced and select the Destination layout tab.

3. Click Add disk.
A new virtual disk appears in the Destination layout column.

4. Click on the new virtual disk to select it.

5. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

The new virtual disk is created on the destination datastore.

Set Up a Virtual Disk as a Logical-Volume Group Container

To preserve the LVM structure when converting a Linux source, you can set up a virtual disk as a logical-volume container.
Converter Standalone allows you to preserve and modify the source LVM structure.

Ensure that the source is a Linux machine and supports LVM.
Only LVM2 is supported.

You can manage logical volumes and logical-volume groups in the same way as basic volumes and disks.
Logical-volume groups are listed together with virtual disks and are marked with a different icon.

You cannot move active and system volumes in a logical-volume group.

1. From the Data copy type drop-down menu, select Select volumes to copy.

2. Click Advanced and select the Destination layout tab.

3. Select a disk and click To LVG.

Move a Disk to a Different Datastore

You can use disk-based cloning to select a different datastore for a destination virtual disk.

On the Options page of the Conversion wizard, click Data to copy in the options list.
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You can change the destination datastore for a disk only for managed destinations with more than one datastore.
1. From the Data copy type drop-down menu, select Copy all disks and maintain layout.

2. Click the name of the virtual disk to relocate and select a different datastore from the Destination datastore drop-
down menu.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

The virtual disk file (. vmdk) is stored in the selected datastore.

Create an Expandable Disk on a Managed Destination

To save space on the destination datastore, you can copy only the existing data from a source and create an expandable
disk on the destination.

On the Options page of the Conversion wizard, click Data to copy in the options list.

You can create expandable disks on managed destinations that support thin provisioning through their GUI.

You can create an expandable disk by using volume-based or disk-based cloning.

* Use disk-based cloning to create an expandable disk.
a) From the Data copy type drop-down menu, select Copy all disks and maintain layout.
b) Click a virtual disk and select Thin from the Type drop-down menu.
c) To apply your settings, select another option from the options list or click Next.
* Use volume-based cloning to create an expandable disk.
a) From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.
b) Select the Destination layout tab, click a virtual disk, and select Thin from the Type drop-down menu.
c) To apply your settings, select another option from the options list or click Next.

Converter Standalone copies only the existing data to the destination datastore. The empty disk space from the virtual
disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of
the destination disk grows.

Create an Expandable Disk on a Hosted Destination

You can save space on the destination virtual machine by coping only the existing data from a source virtual disk.

You must select a hosted destination, such as VMware Workstation, to use the Not pre-allocated disk option.
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On the Options page of the Conversion wizard, click Data to copy in the options list.

You can create an expandable disk by using volume-based or disk-based cloning.

* Use disk-based cloning to create an expandable disk.

a) From the Data copy type drop-down menu, select Copy all disks and maintain layout.
b) From the Type drop-down menu, select Not pre-allocated.
c) To apply your settings, select another option from the options list or click Next.

* Use volume-based cloning to create an expandable disk.

a) From the Data copy type drop-down menu, select Select volumes to copy and click Advanced.
b) Select the Destination layout tab, select a virtual disk, and select Not pre-allocated from the Type drop-down

menu.

c) To apply your settings, select another option from the options list or click Next.

Converter Standalone copies only the existing data to the destination datastore. The empty disk space from the virtual
disk is not copied to the datastore. As you use the destination virtual machine and write new data to the disk, the size of

the destination disk grows.

Exclude a Source Disk from the Conversion Process

You can select a disk from the source machine and delete it from the disk layout of the destination virtual machine.

The source machine must have more than one hard disk.

On the Options page of the Conversion wizard, click Data to copy in the options list.

1. From the Data copy type drop-down menu, select Select volumes to copy.

2. Delete the disk.

Option

Description

Preserve the volumes associated with the disk

1. Click Advanced and select the Destination layout tab.

2. Move the volumes from the disk that you want to delete to
another virtual disks.

3. Highlight the empty disk and click Remove disk.

Delete the volumes associated with the disk

1. Click Advanced and select the Source volumes tab.

2. Deselect the volumes associated with the disk that you want
to delete.

3. Save your settings.

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.

Click Next

Saves your settings and displays the next page of the
Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Copy All Disks to the Destination

To preserve the source disks on the destination virtual machine, you can copy all disks to the destination.
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On the Options page of the Conversion wizard, click Data to copy in the options list.
Disk-based cloning is not available for powered on source machines.
1. From the Data copy type drop-down menu, select Copy all disks and maintain layout.

2. Optional: If the destination datastore is low on disk space, click a virtual disk and select a different datastore from the
Destination datastore drop-down menu.

NOTE
You must have access to more than one datastore to move a disk to a different datastore.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Converter Standalone copies the disks to the selected datastores and preserves the source disk layout.

Create an Optimized Partition Layout

By default, Converter Standalone optimizes the disk partitions alignment to improve the performance of the destination
virtual machine.

On the Options page of the Conversion wizard, click Data to copy in the options list.

1. From the Data copy type drop-down menu, select Select volumes to copy.

2. Select the Create optimized partition layout check box.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Creating an optimized partition layout aligns the partitions on a 1 MB boundary for Windows sources and on a 64 KB
boundary for Linux sources.
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Create a Linked Clone

A linked clone is a VMware virtual machine that shares the virtual disk of the source virtual machine.

¢ Turn off the source virtual machine.
» Verify that your source type is a supported source. See Supported Source Types.

You can create linked clones only after you convert a virtual machine and both the source and destination VMs are in a
hosted destination. You cannot create a linked clone if the source image is password-protected.

1. On the Destination System page, select VMware Workstation or other VMware virtual machine as a destination
and click Next.

2. On the Options page, click Data to copy in the left pane.
In the Data copy type drop-down menu, select Linked clone.

4. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

You have set up a conversion job to create a linked clone.

Edit the Number of Processor Sockets and Cores

You can change the number of virtual sockets and the number of processor cores per socket that the destination virtual
machine uses.

Make sure the destination host and the guest operating system support the number of processor cores you assign to the
destination virtual machine.

NOTE
You can change the number of cores per socket on virtual hardware version 8 and later.

On the Options page of the Conversion wizard, click Devices in the options list.
1. Click the Other tab.

2. From the Number of virtual sockets drop-down menu on the CPU Settings panel, select the number of virtual
sockets for the destination virtual machine.

3. From the Number of cores per socket drop-down menu on the CPU Settings panel, select the number of cores per
socket for the destination virtual machine.

4. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.
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Option Description

Click Next Saves your settings and displays the next page of the
Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

The destination virtual machine is configured with the number of virtual processor sockets and cores that you selected.
If Converter Standalone shows a message that the destination hardware does not support the number of cores you
selected, you must select a supported number of sockets and cores.

Allocate Memory for the Destination Virtual Machine
You can change the amount of memory allocated to the destination virtual machine.
On the Options page of the Conversion wizard, click Devices in the options list.

By default, Converter Standalone recognizes the amount of memory on the source machine and allocates it to the
destination virtual machine.

1. Click the Memory tab.

2. In the Memory panel, use the slider or the spin-box to specify the amount of memory for the destination virtual
machine.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Converter Standalone validates the amount of memory. A warning appears if you set the memory amount to more than
the maximum supported or to less than the required minimum.

Select a Disk Controller for the Destination Virtual Machine

You can select the disk controller type for the destination virtual disks.
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On the Options page of the Conversion wizard, click Devices in the options list.

1.
2.

3.

Click the Other tab.

From the Disk controller drop-down menu, select a disk controller for the destination virtual disk or retain the selected

recommended type.

Option Description

SCSI Bus Logic Use SCSI virtual disks in the destination virtual machine.
IDE Use IDE virtual disks in the destination virtual machine.
SCSI LSI Logic Use LSI Logic SCSI virtual disks in the destination virtual

machine.

SCSI LSl Logic SAS

Use LSI Logic SCSI (SAS) virtual disks in the destination virtual
machine.

Paravirtual SCSI

Use Paravirtual SCSI virtual disks in the destination virtual
machine.

SATA

Use SATA virtual disks in the destination virtual machine.

NVMe

Use NVMe virtual disks in the destination virtual machine.

Preserve source

Use the same types of disk controllers as those installed on the
source machine. If they are not supported on the destination
virtual machine, replace them with supported ones. This option
is not available for powered on Linux sources.

NOTE

Depending on your OS version and the target ESXi version, different Disk controller options are listed in the
VMware vCenter Converter Standalone user interface.

Save your settings.

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.

Click Next

Saves your settings and displays the next page of the
Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Configure the Network Settings of the Destination Virtual Machine

You can change the number of network adapters and select the network that the destination virtual machine uses.

For managed destinations, you can also select the controller type for each network adapter.

1.
2.

On the Options page of the Conversion wizard, select Networks from the options list.

From the Network adapters to connect drop-down menu, select the number of network adapters to be used by the

destination virtual machine.

Configure each of the network adapters for the destination.

Option

Description

For managed destinations

1. From the Network drop-down menu, select the network that
the adapter connects to.
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Option Description

2. From the Controller type drop-down menu, select the
controller type.

For hosted destinations From the Connection type drop-down menu, select the
connection type.

4. To connect an adapter when you power on the destination virtual machine, select the Connect at power-on check
box.

5. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Configure the Network for the Helper Virtual Machine

When you convert a powered on Linux machine, Converter Standalone creates a helper virtual machine on the
destination. The helper virtual machine needs network access to the source machine to clone the source files. By
default, the IP address of the helper virtual machine is assigned by DHCP. Default conversion settings enforce automatic
acquisition of an IPv4 address, IPv6 address, and a DNS server for the helper virtual machine, but you can set up this
network connection manually.

1. On the Options page of the Conversion wizard, click Helper VM network.

2. Optional: To assign a static IPv4 address to the helper virtual machine, on tab IPv4 select Use the following IP
address and specify the IPv4 address, subnet mask, and default gateway.
Make sure that the IP address you specify for the helper virtual machine is not already in use on the network.

3. Optional: If you want the Helper virtual machine to use only IPv4 address, on tab IPv6 deselect the Use IPv6 check
box.

4. Optional: To assign a static IPv6 address to the Helper virtual machine, on tab IPv6 select Use the following IPv6
address and specify the IPv6 address, subnet prefix length, and default gateway.
Make sure that the IP address you specify for the Helper virtual machine is not already in use on the network.

5. Optional: If you want the Helper virtual machine to use only IPv6 address, on tab IPv4 deselect the Use IPv4 check
box.

6. Optional: Select Use the following DNS server address and type the preferred DNS server address to configure the
DNS server address manually.
Optionally, you can type an alternative DNS server address as well.

7. Save your settings.
Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.
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Option Description

Click Next Saves your settings and displays the next page of the
Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Converter Standalone uses the IP address and DNS server you specify to copy data from the source Linux machine to the
Helper virtual machine during conversion.

Configure the Software on the Destination Virtual Machine
You can configure the guest operating system so that it is ready to operate in a virtual environment.

Software configuration includes various settings.

Customize the Windows Guest Operating System

You can customize guest operating systems running Windows so that the virtual machine is prepared to work immediately
in the destination environment.

* On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select
Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization
options.

Customize the Identity of the Destination Virtual Machine

To configure the identity of the destination VM for the destination network, you can customize the guest OS identity and
generate a new security ID.

On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select
Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization
options.

1. On the Customizations page, select Computer information from the options list.

2. Customize the guest operating system identity.
a) In the Computer Name text box, type a computer name to identify the virtual machine on the network.

Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter
Standalone permits it. The recommended length for most languages is 15 characters or less. Computer names
cannot consist only of numerals.

b) In the Owner Name text box, type the name of the owner of the virtual machine.

Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter
Standalone permits it. The owner name cannot have more than 63 characters or consist only of numerals.

c) In the Organization text box, type an organization name.
Valid characters include all printable characters (A-Z, a-z, 0-9, symbols, and space). The limit is 63 characters.

3. Optional: To create a new security identifier, select Generate New Security ID (SID).

By default, the Generate New Security ID (SID) check box is selected for source systems that run Windows Vista or
later and cannot be deselected.

The identifiers of the destination virtual machine are assigned according to your settings.
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You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Enter the Windows License Information

Ensure that you provide licensing information for all destination virtual machines running guest operating systems as
necessary.

On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select
Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization
options.

NOTE
Because of third-party licensing policies, you might not be able to transfer the license from the source machine
and you might need to provide a new valid license for the destination virtual machine.

1. On the Customizations page, select Windows license from the options list.
2. In the Product ID text box, type the licensing information for the destination virtual machine.
3. Optional: If the guest operating system is Windows Server 2008, select Include server license information.
4. Select a Server license mode option.
Option Description
Per seat For individual user licenses.
Per server For a concurrent user license. When you select this option, you
need to type a value in the Maximum connections text box.

The Windows license information is saved to the destination virtual machine after the conversion.

You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Set the Time Zone for the Destination Virtual Machine

You can set the time zone if you are converting a virtual machine to use in a different time zone.

On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select
Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization
options.

1. On the Customizations page, select Time zone from the options list.

2. Select the target time zone from the Time zone drop-down menu.

The time zone is set on the destination virtual machine after the conversion.

You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Configure the Network Adapters

You can configure the network settings of the virtual machine to work with the network configuration of the destination
environment.
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On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select
Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization
options.

The option for configuring network adapters is available for all supported destinations.
1. On the Customizations page, select Network interface settings from the options list.

2. Select a network adapter and click Customize to configure its properties.

a) On the IPv4 tab, type the IPv4 address and DNS server address.

b) On the IPv6 tab, type the IPv6 address and DNS server address.

c) On the DNS tab, configure the DNS connections by adding DNS suffixes.

d) Type a DNS suffix and click Add.
You can add more than one DNS suffix.

e) If you have provided multiple DNS suffixes, use Move up and Move down to set the order in which the guest
operating system uses the connections.

f)  On the WINS tab, type the primary and secondary WINS IPv4 address in the text box.

When powered on, the destination virtual machine uses the network settings that you configured.

You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Assign a Workgroup or Domain Details

You can set up the workgroup and the domain in which the destination virtual machine belongs.

On the Options page of the Conversion wizard, click Advanced options, click the Post-conversion tab, and select
Customize guest preferences for the virtual machine. Click Next to view and adjust the available customization
options.

1. On the Customizations page, select Workgroup/Domain from the options list.

2. Select how the virtual machine participates in the destination network.

Option Description

Workgroup The text box must have a value. Valid characters include A-Z,
a-z, 0-9, space, and the hyphen (-). The maximum length is 15
characters.

Windows server domain The text box must have a value. Valid characters include A-Z, a-
z, 0-9, space, period, and the hyphen (-). The maximum length
is 64 characters. User credentials are required.

The destination virtual machine connects to the specified workgroup and domain server.

You can select another option to set or click Next to view a summary of the conversion job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Install VMware Tools on the Destination Virtual Machine

When converting Windows source machines, you can install VMware Tools to improve graphics performance of the
guest operating system. Other enhancements include automatic grab and release of the mouse pointer, copy and paste
operations between guest and host, and improved mouse performance.
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On the Options page of the Conversion wizard, click Advanced options in the options list.
1. Click the Post-conversion tab.

2. In the Post-conversion processing section, select the Install VMware Tools on the destination virtual machine
check box.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Converter Standalone installs VMware Tools on the destination machine when the destination machine is powered on for
the first time after the conversion job.

Remove System Restore Checkpoints

When you convert source machines running Windows, you can remove System Restore checkpoints so that the
conversion process is faster.

On the Options page of the Conversion wizard, click Advanced options in the options list.

System Restore is enabled on Windows systems by default. If you are performing volume-based file-level cloning, System
Restore checkpoints are removed automatically from the destination virtual machine, regardless of whether the Remove
System Restore checkpoints on destination check box is selected or deselected. If you are performing disk-based
cloning or volume-based block-level cloning, deselecting the check box instructs Converter Standalone to keep the
System Restore checkpoints in the destination virtual machine.

Removing System Restore checkpoints prevents the target machine from reverting to a preconversion state. In the target
virtual machine, restoring a checkpoint that was created before you cloned the source machine can damage the system
and prevent the destination virtual machine from starting up.

1. Click the Post-conversion tab.

2. In the Post-conversion processing section, select the Remove System Restore checkpoints on destination check
box.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.
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Option

Description

Click Next

Saves your settings and displays the next page of the
Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Configure the Conversion Job

You can configure the conversion process and select the behavior of the source and destination machine during and after
conversion. You can change the status of the source and destination services only when the source machine is running a

Windows operating system.

Set the Startup Mode for Destination Services

To minimize downtime for a Windows service, you can select the service and set the service startup mode to automatic,

manual, or disabled.

On the Options page of the Conversion wizard, click Services in the options list.

You can change the settings for the destination services only when you convert source machines that run Windows.

1. If you are converting a powered on source machine, click the Destination services tab.
If the source machine is powered off, the Services pane displays no tabs. You can modify only the starting mode of

destination services.

2. On the services list, select the startup mode for each service.

Option Description

Automatic The service starts automatically after the destination machine is
powered on.

Manual The service does not start after the destination machine is
powered on, but you can start it manually.

Disabled The service is disabled and does not start after the destination

machine is powered on.

3. Save your settings.

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.

Click Next

Saves your settings and displays the next page of the
Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.
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Stop Services Running on the Source Machine

You can make sure that you do not lose data from services running on the source machine. You can select the services
that you want to stop before Converter Standalone synchronizes the data between the source and destination machine.
As a result, the services do not generate data while source and destination machines are synchronized.

On the Options page of the Conversion wizard, click Services in the options list.
You can stop services on the source only when you convert a powered on Windows machine.
1. Click the Source services tab.

2. To stop a service on the source machine before synchronization, highlight a service and select the Stop check box to
the right.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Converter Standalone stops the selected source services before it synchronizes the destination machine with the source
machine.

Synchronize the Destination Machine with Changes Made to the Source Machine

When you convert a powered on Windows machine, Converter Standalone copies data from the source machine to the
destination machine while the source machine is still running and generating changes. This process is the first transfer of
data. You can transfer data for the second time by copying only the changes made during the first transfer of data. This
process is called synchronization.

Stop various source services to make sure they do not generate additional changes during the final synchronization, as
that might lead to data loss.

On the Options page of the Conversion wizard, click Advanced options in the options list.
Synchronization is available only for Windows source operating systems and managed destinations.

If you resize FAT volumes or shrink NTFS volumes, or change the cluster size on the destination volume, you cannot use
the synchronization option.
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You cannot add or remove volumes on the source machine between two cloning tasks of a synchronizable job because it
might cause conversion to fail.

1.
2.
3.

Click the Synchronize tab.
Select Synchronize changes.

Specify when you want to perform the synchronization.

Option

Description

Click Run immediately after cloning

Synchronization is performed immediately after the cloning is
complete.

Click Schedule

Synchronization is performed at the scheduled time and date.
Use the Run at text box to specify the start date and time for the
synchronization.

Select Perform final synchronization if you do not plan to
destination.

Save your settings.

make further synchronizations between the source and the

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.

Click Next

Saves your settings and displays the next page of the
Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Power Off the Source Machine After Conversion

If your source machine is running services that you want to start on the destination virtual machine after conversion, you
can power off the source machine to avoid interference between source and destination services.

On the Options page of the Conversion wizard, click Advanced options in the options list.

1.
2.

Click the Post-conversion tab.

In the Post-conversion power state panel, select Power off source machine.
This option appears in the Post-conversion power state panel only if the conversion source is a remote powered on

machine.

Save your settings.

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.

79



vCenter Converter Standalone 6.6

Option Description

Click Next Saves your settings and displays the next page of the
Conversion wizard.

¢ The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

e The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Converter Standalone powers off the source machine after the conversion is complete.

Power On the Destination Virtual Machine After Conversion

You can minimize the downtime of important services by powering on the destination virtual machine immediately after the
conversion is complete.

On the Options page of the Conversion wizard, click Advanced options in the options list.
1. Click the Post-conversion tab.
2. In the Post-conversion power state panel, select Power on destination machine.

3. Save your settings.

Option Description

Select another option from the options list Saves your settings and displays the pane for the selected
option.

Click Next Saves your settings and displays the next page of the

Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

After the conversion, Converter Standalone powers on the destination machine.

Limit the Amount of Resources Used by the Conversion Job

A conversion job competes for computing resources with other processes. To limit the impact of the conversion job on
other workloads, you can throttle the job. If you do not throttle conversion jobs, they are carried out with normal priority
and depending on the available computing resources during conversion.

A powered on source machine runs its own conversion job. You can limit the impact of the conversion job on other
workloads running on the powered on machine.

For source machines that are not powered on, you can limit the resources used on the machine where Converter
Standalone server is installed.

Throttling controls the CPU and network resources that the conversion process uses. You cannot throttle disk 1/0 from the
Converter Standalone interface, but can throttle it indirectly by throttling the network bandwidth.
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1.

NOTE

You cannot throttle conversion jobs for powered on source machines that run Linux. You cannot throttle
conversion jobs for powered off virtual machines to VMware hosted destinations.

On the Options page, select Throttling from the options list.

2. From the CPU throttling drop-down menu, select the priority of the conversion task.

Option Description

None The priority of the current conversion task is set to normal.

Light The priority of the current conversion task is reduced slightly
below normal.

Medium The priority of the current conversion task is set to lowest.

NOTE

Converter Standalone reduces the thread priorities of conversion tasks to control the CPU resources they

consume.

3. Optional: Select Network bandwidth throttling and specify the maximum network bandwidth at which Converter

Standalone performs the conversion jobs.

4. Save your settings.

Option

Description

Select another option from the options list

Saves your settings and displays the pane for the selected
option.

Click Next

Saves your settings and displays the next page of the
Conversion wizard.

* The Customizations page is displayed if you select
Customize guest preferences for the virtual machine in
the Advanced options pane.

* The Summary page is displayed if you do not select
Customize guest preferences for the virtual machine in
the Advanced options pane.

Uninstall Converter Standalone Agent from the Source Machine

When setting up a conversion job for a powered on Windows source or a Hyper-V Server virtual machine, you can
choose how you want to remove the Converter Standalone agent from the source after the conversion. If the Converter
Standalone agent is installed by the Converter Standalone server, it is uninstalled automatically. Otherwise, you must
uninstall it manually.

Use Add or Remove Programs on the source machine to uninstall the Converter Standalone agent.

1.

2
3.
4

In Windows, run Add or Remove Programs.

In the list of installed programs, locate and click VMware vCenter Converter Standalone Agent.

Click Remove.

In the confirmation dialog box, click Yes.

Windows installer uninstalls the Converter Standalone agent from the source machine.
Review the Summary and Submit the Conversion Job

On the Summary page, you can view a summary of the conversion job before you add it to the job list.
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You must complete all steps in the Conversion wizard to access the Summary page.

The summary includes information about the source machine, the destination virtual machine, and destination
customization settings (if any). Converter Standalone performs job validation at this stage.

1. Review the summary of the job.
2. Click Finish to submit the job.
Converter Standalone validates the job parameters. This might take several minutes. If the validation succeeds, the

conversion job appears in the Job View list in the main application window. You can find information about the tasks of the
job in the Task View. If the validation fails, you must click Back and correct the invalid parameters as prompted.

Configure Virtual Machines

You might need to configure a virtual machine after you convert it so that it is ready to run in the destination virtual
environment. You might also need to configure virtual machines if their virtual environment changes or if you need to
improve their performance.

NOTE
You can configure only VMware virtual machines that run Windows. You cannot configure virtual machines that
run operating systems other than Windows.

Unlike the conversion process, which is nondestructive to the source machine, the configuration process affects the
source. When you create a configuration job, your settings are applied to the configuration source machine and cannot be
reverted.

Start the Configuration Wizard

You can configure VMware desktop virtual machines or virtual machines managed by ESXi hosts or vCenter Server.
A powered on machine cannot be a configuration source.

You can configure only powered off virtual machines.

1. Start the VMware vCenter Converter Standalone application.

2. Click Configure machine in the application menu.

The Configuration wizard opens.

Select the source machine to configure.

Select a Source Machine to Configure
You can select a powered off VMware virtual machine as the source for a configuration task.
On the Source System page of the Configuration wizard, select a source type from the drop-down menu.

On the Options page of the Configuration wizard, you can select the required configuration options.

Select a vSphere Virtual Machine to Configure

You can configure vSphere virtual machines. A vSphere virtual machine is a virtual machine that runs on an ESXi host or
on an ESXi host managed by vCenter Server.

Power off the source machine before the configuration.
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In the main application window of Converter Standalone, click Configure machine to open the Configuration wizard.

1. On the Source System page of the Configuration wizard, select VMware Infrastructure virtual machine from the
Select source type drop-down menu.

2. Provide the IP address or host name and credentials for authentication with the ESXi host or the vCenter Server, and
click Next.

The Source Machine page appears, displaying the host name or IP address and the inventory of the ESXi host or the
vCenter Server.

On the Source Machine page of the Configuration wizard you can browse the virtual infrastructure inventory and select
the virtual machine to configure.

Specify the vCenter Server Virtual Machine to Configure

If you choose to configure a virtual machine managed by a or ESXi host, you must browse the inventory to locate the
source virtual machine.

On the Source System page of the Configuration wizard, select VMware Infrastructure virtual machine as the
configuration source and click Next to proceed to the Source Machine page.

1. Optional: If you are connected to a vCenter Server, select a virtual machine view from the Specify machine with
drop-down menu.

Option Description

Hosts and Clusters The Inventory tree pane provides a view of hosts, clusters,

resource pools, and vApps. If you select a host managed by a

cluster, you see the full list of virtual machines and templates in

the virtual machine list view. If you select a standalone host or a

cluster, you see only the virtual machines that are not deployed

in the resource pools of that host or cluster.

VMs and Templates The Inventory tree pane provides a view of datacenters and
virtual machine folders.

2. Optional: If you are connected to a vCenter Server, select an object from the Inventory tree pane.

Option Description
Hosts and Clusters Select cluster, ESXi host, resource pool, or vApp.
VMs and Templates Select datacenter or virtual machine folder.

3. From the virtual machines list, select the virtual machine you want to configure.

You can search for virtual machines in the virtual machine list by typing one or more letters of their names in the
Search for name with text box. You can clear your search by clicking Clear.

NOTE
You cannot select a virtual machine from an ESXi host that is powered off, connected to another vCenter

Server, or in maintenace mode.
4. Optional: To refresh the inventory, click Refresh.
5. Optional: To view more details about a machine, select it and click View source details.
6. Click Next to proceed to the Options page.

On the Options page of the Configuration wizard, you can select the required configuration options.
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Select a VMware Desktop Virtual Machine to Configure
You can configure standalone VMware virtual machines created with , , or VMware Player.

If you plan to use a network path to locate the source, verify that the machine where Converter Standalone server runs
has access to that network path.

In the main application window of Converter Standalone, click Configure machine to open the Configuration wizard.

1. On the Source System page of the Configuration wizard, select VMware Workstation or other VMware virtual
machine.

2. Locate the virtual machine source.

* |f you are connected to a remote Converter Standalone server, provide a network path to the source virtual
machine file (. vmx) in the Virtual machine file text box. For example, \\server\virtual machines
\virtual machine.vmx.

* If you are connected to a local Converter Standalone server, provide a network path or a local path to the . vmx file.
By default, only VMware virtual machine * . vinx files are displayed.

3. If you are connected to a remote Converter Standalone server, type user credentials for accessing the source virtual
machine.

You do not have to provide user credentials if you are connected to a local Converter Standalone server. In such
cases, Converter Standalone uses the Windows credentials to connect to the source machine.

4. Optional: To view more information about the selected source, click View source details.
5. Click Next to proceed to the Options page.

On the Options page of the Configuration wizard, you can select the required configuration options.

Select the Options to Configure
When you create a configuration job, you can select the steps of the configuration process that you want to run.

¢ On the Options page, select one or more configuration steps to perform and click Next.
Option Description

Install VMware Tools on the destination virtual machine Installs VMware Tools to enhance the performance of the
destination virtual machine.

Customize guest preferences for the virtual machine Lets you customize Windows guest operating systems so that
you can prevent and resolve licensing and networking issues.

Remove System Restore checkpoints on destination Removes System Restore checkpoints from the destination
virtual machine.

Reconfigure destination virtual machine Modifies the configuration of the virtual machine so that it is
prepared to boot and work properly in the destination virtual
environment.

On the basis of the configuration options you selected, you can either customize the guest operating system of the source
virtual machine or view the Summary page of the Configuration wizard.

Install VMware Tools on a Virtual Machine
Install VMware Tools to improve graphics performance for the guest operating system of a configured virtual machine.

Install VMware Tools on the virtual machine you are configuring. VMware Tools enhancements include automatic grab and
release of the mouse pointer, copying and pasting between guest and host, improved mouse performance, and so on.
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On the Options page of the Configuration wizard, select Install VMware Tools on the destination virtual machine and
click Next.

vCenter Converter Standalone installs VMware Tools on the configured virtual machine.

You can customize the guest operating system or view the Summary page of the Configuration wizard.

Customize the Windows Guest OS
As a part of the configuration job, you can customize virtual machines running Windows.

* On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and
click Next to view and modify the available customization options.

Customize the Identity of a Virtual Machine

To configure the identity of a virtual machine on a virtual network, personalize the virtual machine by editing its name,
owner, and organization name, and by generating a new security ID.

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and
click Next to view and modify the available customization options.

1. On the Customizations page, select Computer information from the options list.

2. Customize the guest operating system identity.
a) In the Computer Name text box, type a computer name to identify the virtual machine on the network.

Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter
Standalone permits it. The recommended length for most languages is 15 characters or less. Computer names
cannot consist only of numerals.

b) In the Owner Name text box, type the name of the owner of the virtual machine.

Valid characters include A-Z, a-z, 0-9, and the hyphen (-). The underscore (_) is nonstandard, but Converter
Standalone permits it. The owner name cannot have more than 63 characters or consist only of numerals.
c) Inthe Organization text box, type an organization name.

Valid characters include all printable characters (A-Z, a-z, 0-9, symbols, and space). The limit is 63 characters.

3. Optional: To create a new security identifier, select Generate New Security ID (SID).
By default, the Generate New Security ID (SID) check box is selected for source systems that run Windows Vista or

later and cannot be deselected.
The identifiers of the configured virtual machine are assigned according to your settings.

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Specify the Windows License Information

Ensure that you provide licensing information for all destination virtual machines running guest operating systems as
necessary.
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On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and
click Next to view and modify the available customization options.

1. On the Customizations page, select Windows license from the options list.

2. In the Product ID text box, type the licensing information for the destination virtual machine.

3. Optional: If the guest operating system is Windows Server 2008, select Include server license information.
4

. Select a Server license mode option.

Option Description

Per seat For individual user licenses.

Per server For a concurrent user license. When you select this option, you
need to type a value in the Maximum connections text box.

The Windows license information is saved to the configuration source machine when the configuration task is completed.

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Set the Time Zone on Destination Machine

You can configure the time zone for a virtual machine.

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and
click Next to view and modify the available customization options.

1. On the Customizations page, select Time zone from the options list.

2. Select the target time zone from the Time zone drop-down menu.

The time zone is set on the destination machine when the configuration job completes.

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Reconfigure the Network Adapters

You can change the network settings of a virtual machine to work with the network configuration of the virtual
environment.
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On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and
click Next to view and modify the available customization options.

The options for configuring network adapters are available for all supported customization sources.
1. On the Customizations page, select Network interface settings from the options list.

2. Select a network adapter and click Customize to configure its properties.
a) On the IPv4 tab, type the IPv4 address and DNS server address.
b) On the IPv6 tab, type the IPv6 address and DNS server address.
c) On the DNS tab, configure the DNS connections by adding DNS suffixes.
d) Type a DNS suffix and click Add.
You can add more than one DNS suffix.

e) If you have provided multiple DNS suffixes, use Move up and Move down to set the order in which the guest
operating system uses the connections.

f)  On the WINS tab, type the primary and secondary WINS IPv4 address in the text box.
When powered on, the configured virtual machine uses the network settings that you specified.

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Configure a Workgroup or Domain Details

You can assign a workgroup and the domain for a virtual machine.

On the Options page of the Configuration wizard, select Customize guest preferences for the virtual machine and
click Next to view and modify the available customization options.

1. On the Customizations page, select Workgroup/Domain from the options list.

2. Select how the virtual machine participates in the destination network.
Option Description

Workgroup The text box must have a value. Valid characters include A-Z,
a-z, 0-9, space, and the hyphen (-). The maximum length is 15
characters.

Windows server domain The text box must have a value. Valid characters include A-Z, a-
z, 0-9, space, period, and the hyphen (-). The maximum length
is 64 characters. User credentials are required.

The configured virtual machine connects to the specified workgroup and domain server.

You can select another option to set or click Next to view a summary of the configuration job. If the Next button is inactive,
check the Current settings list for other settings that need your attention on this page.

Remove System Restore Checkpoints From Source Machine

You can prevent newly imported source machines to revert to a pre-conversion state by removing their system restore
checkpoints.

For other configuration source machines, removing System Restore checkpoints helps you save disk space by deleting
unnecessary data.

On the Options page of the Configuration wizard, select Remove System Restore checkpoints on the destination
and click Next.

The System Restore checkpoints are deleted from the configuration source machine.
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You can customize the guest operating system or view the Summary page of the Configuration wizard.

Reconfiguring a Virtual Machine To Boot Properly

If a newly converted virtual machine does not start properly in the destination virtual environment, try reconfiguring it with
Converter Standalone.

A number of configuration issues might prevent a newly created virtual machine from starting properly. For example,
Converter Standalone might need to deactivate some legacy drivers to allow the virtual machine to operate. If the
operating system on the source machine is not on the default drive, the boot . ini file or the BCD might need to be
modified so that the destination virtual machine can start.

On the Options page of the Configuration wizard, select Reconfigure destination virtual machine and click Next.
Converter Standalone reconfigures the destination virtual machine so it can boot in the virtual environment.
Review and Submit the Configuration Job

After you review your settings on the Summary page of the Configuration wizard, you can go back and change a setting
or submit the job.

1. Review the summary of the settings for the source virtual machine.

2. Click Finish to submit the configuration job.

The job appears in the jobs list in the Job View list of the main application window. You can view the progress of the
current task on the Task progress tab in Task View.

To view details about the configuration task, click the Summary tab.

Manage Conversion and Configuration Jobs and Tasks

Converter Standalone provides a manager for managing conversion and configuration jobs and tasks.

After you create a conversion or configuration job by using the Converter Standalone wizards, you can use the Task View
and the Job View of the Converter Standalone manager to monitor and manage the existing jobs and their tasks.

Scheduled synchronized conversion jobs can contain multiple tasks.

Manage Jobs in the Job List

The Job View of the Converter Standalone manager provides a list of all jobs that are submitted. You can use the main
application menus to control the way jobs appear in the job list and to edit them.

You must submit a conversion or configuration job to view it in the job list.

You must be in the Job View of the Converter Standalone manager to access the application menus for job managing.

Add a Job to the Job List

With Converter Standalone you can create and run conversion and configuration jobs.

On the Summary page of the Conversion or the Configuration wizard, make sure no settings need adjustment, and click
Finish to add a conversion or configuration job.

The job appears at the beginning of the job list in the Job View and its tasks appear in the Task View.

In the job list, you can view the job status, which task of the job is currently running, and other details. You can also delete
a job, and perform other job operations.
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View the Running Task of a Job

You can switch from Job View to Task View to view and edit the currently running task of a job.
1. From the View by drop-down menu on the toolbar, select Jobs.

2. From the job list, select a job.

3. On the main menu, select Job > Go to running task.

The Converter Standalone manager switches to Task View and preselects the currently running task of the job you
selected in Job View. If none of the job's tasks is running, no selection is made.

Deactivate a Job

You can deactivate an active job without applying any changes to the destination machine.

NOTE
You can deactivate a job only if none of its tasks is currently running.

1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the job you want to deactivate.

3. From the main menu, select Job > Deactivate.

The job state changes to inactive and no changes are applied to the destination.

NOTE
An inactive job cannot be reactivated.

Delete a Job
You can delete a job and all its tasks.
You can delete only deactivated jobs.
1. From the View by drop-down menu on the toolbar, select Jobs.
2. From the job list, select the job you want to delete.

3. From the main menu, select Job > Delete.

The job is removed from the job list, and all the tasks of the job are removed from the task list.

Create a Job by Copying an Existing Job

You can create a new job by creating a copy of an existing job and modifying its settings in the Conversion or the
Configuration wizard.

The settings for the original job appear at each step of the wizard so that you can reuse or change them.
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NOTE
You can copy only jobs that were created with the Converter Standalone client.

From the View by drop-down menu on the toolbar, select Jobs.
From the job list, select the job you want to copy.

Select Job > Copy As New.

Follow the prompts to modify the job settings.

Click Finish to add the new job the job list.

o D=

Filter the Jobs in the Jobs List
You can select the jobs that you want the job list to display by filtering them.
You can filter jobs by history, status, or multiple criteria.

Filter Jobs by History

You can filter the list so that it displays only the last submitted jobs. By default, the job list displays the last twenty jobs.
1. From the View by drop-down menu on the toolbar, select Jobs.

2. On the main menu, click View > History Filter and select a level of filtering.

Only jobs that correspond to selected filtering level remain in the job list.
Filter Jobs by Status

You can filter the job list to display jobs based on their status. By default, the job list displays all jobs.
1. From the View by drop-down menu on the toolbar, select Jobs.
2. On the main menu, select View > Filter by.

3. Select a level of display from the drop-down menu.

If you are connected to a remote Converter Standalone server, you can select My own to view only jobs that you have
created.

Filter Jobs by Multiple Criteria

You can combine filtering criteria to filter jobs in the job list.
1. From the View by drop-down menu on the toolbar, select Jobs.

2. Use the drop-down menus in the toolbar to select the status and the history criteria.
The two filtering conditions combine to show only jobs that comply with both conditions.

Add a Synchronization Task to a Conversion Job

You can add a synchronization task to an active conversion job and modify the synchronization settings in the Conversion
wizard.

The conversion job must be active and allow synchronization.
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No synchronization task that belongs to this job must be running.

NOTE
You can add synchronization tasks only to jobs that were created with the Converter Standalone client.

From the View by drop-down menu on the toolbar, select Jobs.
From the job list, select the conversion job to which you want to add a synchronization task.
From the main menu, select Job > Synchronize.

Follow the prompts to modify the synchronization settings.

o D=

. Click Finish to save changes.

Manage Tasks in the Task List

The Task View of the Converter Standalone manager provides a list of all tasks that are submitted.

You must submit a conversion or configuration job to view its tasks in the task list.

You must be in the Tasks View of the Converter Standalone manager to access the application menus for managing task.

You can use the main application menus to control the way tasks appear in the task list and to edit them.

Control the Number of Tasks Running Concurrently
To improve the conversion speed, you can limit the number of tasks that run concurrently.

Limiting the number of concurrent tasks helps you reduce the required network resources and to limit the CPU load on the
machine where the Converter Standalone server runs. You can set the number of concurrent tasks to any number from 1
to 12. The default number of concurrent tasks is set to Maximum.

1. On the main menu, select Administration > Maximum Concurrent Tasks.
2. In the Custom spin-box, specify a number.
3. Click OK.

The setting takes effect immediately for all newly added tasks. See Limiting the Number of Concurrent Tasks .
Limiting the Number of Concurrent Tasks

Assume that Converter Standalone is running 12 tasks. If you change the number of concurrent tasks to 6,
these 12 tasks continue running, but all newly added tasks remain pending in the task list. When the number
of running tasks drops to 5, a new task from the wait list starts.

Set the Number of Data Connections per Task

If you are converting sources with multiple disks and volumes, you can decrease the conversion time by cloning multiple
disks and volumes concurrently. This option is supported for conversions of Windows sources and Linux virtual sources.

When you clone multiple disks and volumes in parallel, each data transfer uses a separate TCP connection.

NOTE

For managed sources and destinations, the number of the concurrent data connections within a conversion
task must not exceed the TCP connections limit of the corresponding ESXi host. Otherwise, the conversion task
might not complete successfully.
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The source conversion completes and the task of configuring the destination starts only when all data transfers are
complete.

1. On the main menu, select Administration > Data Connections per Task.

2. Select the number of concurrent data connections.
Option Description

Select the Maximum check-box . All disks and volumes of the source are cloned simultaneously.

In the Custom spin-box, select a number between 1 and 12. |Only a specific number of disks and volumes are cloned
simultaneously. The default number of concurrent data
connections per task is set to 1.

3. Click OK.

The setting takes effect immediately for all newly added tasks.

View the Job to Which a Task Belongs

You can switch from Task View to Job View to view and edit the job to which a selected task belongs.
1. From the View by drop-down menu on the toolbar, select Tasks.

2. From the task list, select a task.

3. On the main menu, select Task > Go to job.

The Converter Standalone manager switches to Job View. The job that contains the task you selected in Task View is
preselected in the list and complies with the current filter of the Job View.

Cancel a Task
You can cancel a task that is in the queue or in progress.

When you cancel a conversion task that is running, the task is stopped. When you cancel a conversion task that is
queued, the task is removed from the queue. When you cancel a task that is not a synchronization task, the job to which
the task belongs is deactivated. Canceled tasks cannot be restarted.

NOTE
You cannot cancel configuration tasks.

1. From the View by drop-down menu on the toolbar, select Tasks.
2. From the task list, select the task you want to cancel.
3. Click Cancel.

The task is now stopped or removed from the queue, and the time of cancellation appears in the End Time column.

Filter the Tasks in the Task List

The number of archived tasks can expand to be very large. To minimize clutter in the task list, you can lower the number
of tasks that appear.

You can select the tasks that you want the task list to display by filtering them by history, status, or multiple criteria.
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Filter Tasks by History

You can use the date on which a task is created to filter the task list.
This option does not affect tasks in progress. Tasks in progress always appear in the task list.
1. From the View by drop-down menu on the toolbar, select Tasks.

2. On the main menu, click View > History Filter and select a level of filtering.

Only tasks that correspond to the selected filtering level remain in the task list.

Filter Tasks by Status

You can change which tasks appear in the task list based on their running status.
1. From the View by drop-down menu on the toolbar, select Tasks.
2. On the main menu, select View > Filter by.

3. Select a level of display from the drop-down menu.

If you are connected to a remote Converter Standalone server, you can select My own to view only tasks of jobs that
you create.

Filter Tasks by Multiple Criteria
You can combine criteria to filter tasks in the task list. Tasks that are currently running are displayed regardless of the
filtering criteria.
1. From the View by drop-down menu on the toolbar, select Tasks.
2. Use the drop-down menus to select the status and history criteria.
The two filtering conditions combine to show only tasks that comply with both conditions.
Verify Jobs and Tasks Progress and the Log Files

You can observe the progress and the state of the listed jobs and tasks by using the Task View and Job View of the
Converter Standalone user interface.

If certain problems cause a job or task to fail, you can also review information in the log files.

View Task Progress

The Task view and the Details view show the progress of tasks. You can view the estimated time left to the completion of
a conversion task in the End Time column.

You can obtain a general indication of a task's progress by looking at its row in the task list of the Task view. You can view
the Task progress tab in the Details view for more information.

1. From the View by drop-down menu on the toolbar, select Tasks.

2. Select the row in the task list for the task to view.
The information for that task appears in the Details pane below the tasks list.
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3. To view the task status and log highlights, click the Task progress tab.

Export the Log Files for a Job

You can export the log files for one or more jobs. Then, you can review the log files or send a copy of log files to VMware
technical support.

1. From the View by drop-down menu on the toolbar, select Jobs.

2. Select ajob in the job list.

3. On the main menu, select Job > Export Logs.

4

. Select a location to which you want to save the files and click Save.

The log files for all tasks of the selected job are saved to the selected location.

Export the Log Files for a Task

You can review information about any task in the log files. You can also export the log files for a specific task in the task
list.

1. From the View by drop-down menu on the toolbar, select Tasks.
2. Select the task in the task list.

3. In the Details pane, click the Task Progress tab.

4. Click Export Logs.
5

. Select a location to which you want to save the files and click Save.

The log files for this task are saved to the selected location.

Back-End and Client Log Files Locations
Converter Standalone saves log files as it operates.

Table 15: Log Files Locations lists the default locations where log files are saved. You can view the log files or send them
to VMware support, if necessary.

If you are running a remote hot clone, these file locations are also the file locations on the remote machine. To send these
log files from a remote machine to VMware support, you must manually compress and send them.

Table 15: Log Files Locations

Log Files File Path
Converter Standalone server and agent log files $ALLUSERSPROFILES\VMware\VMware vCenter

Converter Standalone\

Converter Standalone client log files $USERPROFILE%\Local Settings\Application
Data\VMware\VMware vCenter Converter
Standalone Client)\
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Documentation Legal Notice

This Documentation, which includes embedded help systems and electronically distributed materials, (hereinafter referred
to as the “Documentation”) is for your informational purposes only and is subject to change or withdrawal by Broadcom

at any time. This Documentation is proprietary information of Broadcom and may not be copied, transferred, reproduced,
disclosed, modified or duplicated, in whole or in part, without the prior written consent of Broadcom.

If you are a licensed user of the software product(s) addressed in the Documentation, you may print or otherwise make
available a reasonable number of copies of the Documentation for internal use by you and your employees in connection
with that software, provided that all Broadcom copyright notices and legends are affixed to each reproduced copy.

The right to print or otherwise make available copies of the Documentation is limited to the period during which the
applicable license for such software remains in full force and effect. Should the license terminate for any reason, it is your
responsibility to certify in writing to Broadcom that all copies and partial copies of the Documentation have been returned
to Broadcom or destroyed.

TO THE EXTENT PERMITTED BY APPLICABLE LAW, BROADCOM PROVIDES THIS DOCUMENTATION “AS

IS” WITHOUT WARRANTY OF ANY KIND, INCLUDING WITHOUT LIMITATION, ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NONINFRINGEMENT. IN NO EVENT WILL
BROADCOM BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY LOSS OR DAMAGE, DIRECT OR INDIRECT,
FROM THE USE OF THIS DOCUMENTATION, INCLUDING WITHOUT LIMITATION, LOST PROFITS, LOST
INVESTMENT, BUSINESS INTERRUPTION, GOODWILL, OR LOST DATA, EVEN IF BROADCOM IS EXPRESSLY
ADVISED IN ADVANCE OF THE POSSIBILITY OF SUCH LOSS OR DAMAGE.

The use of any software product referenced in the Documentation is governed by the applicable license agreement and
such license agreement is not modified in any way by the terms of this notice

The manufacturer of this Documentation is Broadcom Inc.

Provided with “Restricted Rights.” Use, duplication or disclosure by the United States Government is subject to the
restrictions set forth in FAR Sections 12.212, 52.227-14, and 52.227-19(c)(1) - (2) and DFARS Section 252.227-7014(b)
(3), as applicable, or their successors.

Copyright © 2005-2025 Broadcom. All Rights Reserved. The term “Broadcom” refers to Broadcom Inc. and/or its
subsidiaries. All trademarks, trade names, service marks, and logos referenced herein belong to their respective
companies.
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